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Installation
Welcome to Specify!
We are so glad you are taking a peek at our newly revised Specify 5.2 help document.
Whether you are new to Specify, or are a tempered Specify veteran looking for specific
answers, here are some helpful tips.
•

We offer free and friendly support to help you get started and unlimited assistance as
a registered collection. We invite you to call or email anytime about using Specify with
your collections data, Specify Staff is eager to provide assistance.

•

You have already discovered this help document, which you can search or browse as
part of the online Windows help. We have put an appropriately formatted version of
this help document on the Specify Project web site. This manual is one of two manuals
offered. This manual is specifically for installation and setup of Specify 5.2. For
everyday use and data entry instructions and examples please refer to the Specify 5.2
Guide. On paper, this manual is about 240 pages long, print a double-sided copy if you
can!

•

With the release of Specify 5.2, we have expanded the coverage of the narrated user
help and number of our animated tutorials that introduce Specify features and
commonly used Specify functions. Links to the tutorial movies can be found on the
Specify Project website.

•

The Specify 5.2 installation package includes a demonstration database “Fishdemo”
and a blank database for starting a new specimen database. If you install Fishdemo,
you can experiment with it to test menu items and functions. The help document also
uses Fishdemo to illustrate Specify concepts.

•

A final tip, if you find that using a mouse is not as efficient as keeping your fingers on
the keys, check out our Keyboard Shortcuts page in the Specify 5.2 Help Guide for key
stroking your way around Specify.

Specify Software Project
Biodiversity Research Center
University of Kansas
1345 Jayhawk Blvd.
Lawrence, KS 66045-7561, USA
Phone: +1 (785) 864-4400, 8 AM–5 PM
U.S. Central Time (UTC/GMT-6), Monday–Friday, or
Leave a message any time and we will return your call.
Fax: +1 (785) 864-5335
Email: specify@ku.edu
Web: http://www.specifysoftware.org
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Installation Overview
Your Specify collection data resides in a SQL database manager or engine. The Specify
application manages access to the database and provides a user interface for viewing, adding,
and modifying data.
The Specify installation process consists of two steps:
1. Installing a database engine or installing tools to provide connectivity to an existing
Specify database.
2. Installing the Specify application.
This guide is applicable for installing Specify for the first time or updating from Specify 4.x or
5.x. If you are updating from Specify 3.2 or earlier versions, please contact the Specify staff for
assistance at (785) 864-4400 or specify@ku.edu.

Stand-Alone or Client/Server
Specify is used in either of two ways.
1. Install the database, the database engine, and the Specify application on a single computer.
This configuration is best for small collections, where a single Specify computer is used for all
searches, reports, and data entry. This standalone configuration is the easiest option for
institutions that are evaluating Specify for the first time.
2. Install the Specify database on a networked computer that acts as a server. You can then
install the Specify program on other computers on the network, and users on those computers
can simultaneously run copies of Specify with a single shared database.
The steps for installing the Specify application are similar for either configuration. However, the
steps for installing the database manager or "engine" are different and are summarized in the
following two sections.

Configuring Specify on one Computer
If you plan to have the Specify program and your Specify collection data on one computer,
make sure a compatible database engine is installed on the same computer. Specify works
with two database engines: Microsoft SQL Server 2005 Express and Microsoft SQL Server
2005. Microsoft distributes SQL Server 2005 Express and it requires no end-user licensing fee.
SQL Server 2005 Express is the preferred solution if you have a small- to medium-sized
collection (say, in the near term with fewer than 500,000 computerized specimens) and you
don't require direct access to the database from outside of Specify. On the other hand, you
should consider using the full version of Microsoft SQL Server 2005 if:
•

Your database contains (or will in the near future contain) over one million records;

•

You anticipate a need to manipulate the database from an application outside of Specify;

•

You anticipate the possibility of more than five users regularly accessing the database at
the same time;

•

You plan to use the Specify web interface feature to make your data available to a large
community of users over the Internet.

Microsoft SQL Server supports everything from single-user PCs to multiple-user,
multiprocessor servers with terabyte-sized archives. SQL Server requires a licensing fee and is
usually heavily discounted for academic and research use. Contact your Microsoft software
vendor to learn how to purchase and install MS SQL Server.
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Configuring one Specify System on Several Computers
If your Specify application will connect to a Specify database on a different computer, make
sure your computer has the software necessary to act as a "SQL Server client." Windows 2003
and Windows XP Professional systems have built-in SQL Server client capability and do not
require additional software.

Completing the Installation
After you have installed a database engine or configured your system to access a remote
database, run the Specify installer, as described in Install Specify.
After Specify is installed, you'll need to configure your Specify collection. Refer to Setup
Overview for more on configuring your collection in Specify.
Specify also includes some optional components that require additional installation steps:
•

The Specify Web Interface is an optional web server facade that lets users connect to the
Specify database through a web browser for viewing purposes only.

•

The Specify DiGIR Provider is a web-based application that lets your Specify database
participate in a DiGIR community such as GBIF, MANIS, PaleoPortal, OBIS, or HerpNet.
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Specify System Requirements
The computer you use for Specify should have the following:
•

Processor: 1 GHz minimum; 2 GHz recommended.

•

Memory: 512 MB minimum; 1 GB recommended.

•

Disk Space: 1 GB plus 2 MB per 1000 Specify records. Specify requires 60 MB (including
the Fishdemo database and blank database). If you plan to use Specify's web interface or
the Specify DiGIR provider, you will need 10 GB and at least 2 GB of free space after
installation. If you plan to use the express searching feature, you will need twice the
amount of disk space that your collection database normally requires.

•

Video Display: SVGA 1024x768 minimum.

•

Operating System: Windows XP Professional, Windows 2003 Server.

•

Database Engine: Microsoft SQL Server 2005 Express Edition has superseded MSDE
and SQL Server 2005 has superseded SQL Server 2000.
•

Microsoft SQL Server 2005 will only utilize 1CPU and at least 1 GB of RAM. Also,
databases have a 4 GB limit.

•

Web Interface: To use the Specify web interface or DiGIR provider, you will need to have
a JSP server such as Apache Tomcat or Sun Application Server. Additionally, you will
need to have the Java Runtime Environment Version 1.5 or later.

•

DiGIR: To be a DiGIR provider, you will need to have a web server such as Microsoft IIS
or Apache configured to use PHP.

•

Network: If you use the DiGIR provider or HTML interface, you will also need a static IP
address and a broadband connection to the Internet from the computer hosting those
services.

Uninstalling the Previous Web Interface
The Specify Web Interface has been completely redesigned for Specify 5.2. If you were using
the web interface from a previous version of Specify, you will need to remove it. You will also
need to DELETE ALL PREVIOUS WEB QUERIES as instructed in step 3 below.
Background Information
For version 5.2, the web interface has been completely rewritten and redesigned. It is now
Java-based and harnesses the power of the Express Search tables. Previous versions of the
web interface should be removed. Unfortunately, the changes you made to the CSS file in
previous version will have to be redone as well.
To uninstall an existing Specify web interface:
1. Shut down Microsoft IIS or the Apache web server as appropriate and manually delete the
directories used for html and scripts.
2. Delete the System DSN for SpecWeb using ODBC. To do this, choose Start > Settings >
Control Panel, then double-click on Administrative Tools. In the Administrative Tools list,
double-click Data Sources (ODBC), then click on the System DSN tab, select SpecWeb,
and click the Remove button.
3. If you are using any version of Specify, you will need to delete the original queries.
4. After installing Specify, you can recreate the web searches (See Configure the Web
Interface).
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Installation Procedures
Install a Data Server
To use Specify you will need to have a data server installed. If you are installing a new data
server, Specify recommends you can choose either SQL Server 2005 Express, which is freely
available from Microsoft, or the full version, which must be purchased. Microsoft SQL Desktop
Edition (MSDE) should be avoided for new installations, as it is no longer supported by
Microsoft. Windows Vista does not support SQL Server 2000 either.
Install SQL Server 2005 Express
1. Open a web browser (Internet Explorer, Firefox, etc.) and typing in the URL:
http://msdn.microsoft.com/vstudio/express/sql/download/

2. If a message indicating you need to install Microsoft .NET framework 2.0 pops up,
continue with step 3. If not, go to step 12.

3. Open a new browser window and type in the URL: http://msdn2.microsoft.com/enus/netframework/aa731542.aspx. Select Download x86 version of the .NET Framework
Version 2.0 Redistributable Package.
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4. Click Download.

5. When the download has completed start the dotnetfx.exe file.

6. The installer will extract the files it needs.

7. When the installer begins, you will see this opening dialog, click Next.

6

Installation
8. Read and Accept the End-User License Agreement, then click Install at the bottom of the
screen.

9. You will see several progress dialogs as the .NET 2.0 framework is installed. Installation
may take several minutes.
10. When the .NET installer has finished, Click Finish.
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SQL Server 2005 Express Setup
1. Now go back to http://msdn.microsoft.com/vstudio/express/sql/download/ and download
SQL Server 2005 Express and SQL Server Management Studio Express. Please note
that if you have a 64-bit edition of Windows the Management Studio installer is located
just above the "Need Help?" heading.

2. After the files are downloaded, click the SQLEXPR32 file to start it.

3. The installer will extract the files it needs to a temporary directory.
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4. Read and Accept the End-User License Agreement, then click Next.

5. A dialog will appear giving you a summary of the required components to install. Click
Install. After it has completed, click Next.

9

Specify 5.2 Installation and Setup Guide
6. The next interactive dialog will be this one, click Next to continue.

7. The installer will perform a system check, if any of the parts fail, you will need to address
them.
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8. You will now see another progress dialog.
9. After the required components are installed click Next. Follow the prompts until you get to
the following dialog. When you get to the dialog, enter your name and company
information and click Next.

10. Specify suggests installing the Client Components as well as Database Services. Then
click Next.
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11. This dialog lets you set up how you will connect to SQL Server. Click the mixed mode
button.
Important: Windows Authentication Mode should only be used if mandated by
institutional protocols.

Enter and confirm a password for the "sa" user. Then click next.
Important: You will need to remember this password for future attaching and detaching
of databases as well as the Express Search Build process within Specify
12. Enable user instances at this next dialog. You do not need to check the other box unless
you are using Windows Vista. Then click Next.
13. The next dialog will set up your error and usage reporting settings. Choose if you would
or would not like to send reports to Microsoft.
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14. Follow the prompts and the installation will begin. The next dialog will have a progress
bar. Click next when the installation is finished.

Management Studio Express Setup
1. Now install SQL Server 2005 Management Studio Express by running "SQL Server
2005_SSMSEE.exe".
2. The Welcome Screen appears. Click Next to begin installation.
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3. Read and accept the End-User License Agreement then click Next at the bottom of the
screen.
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4. Next enter your name and your company name information and continue.

5. The Feature Selection dialog box appears. Specify recommends the default setting. Click
Next.
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6. Continue following the prompts to install. While the product is being installed, you will see
this dialog.

7. Click "Finish" at the final dialog and the installation will be complete.
8. The default instance name for your new server will be "SQLEXPRESS".
9. When you attach and log into your database you will use the server: {Machine
Name}\SQLEXPRESS. In the example below, the machine name is "SPECIFY7GGQU5A".
If you are installing a new instance of SQL 2005 Express before installing Specify (5.1
or later), the installer will detect your server name when attaching the blank or demo
database. If you are installing SQL 2005 Express and do not upgrade your existing
server instance, you will need to detach your database(s) from your existing server and
attach them to the new server. You will also need to move the .mdf file to the data
directory for SQL Server 2005 Express (by default it is: C:\Program Files\Microsoft SQL
Server\MSSQL.1\MSSQL\Data) and delete the log file before attaching to the new
server. Specify recommends you upgrade your existing MSDE instance rather than
creating a new instance for these reasons.
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Open the Windows Firewall
If you are installing Specify on a machine other than the one your data server is on, you will
need to open your firewall to allow SQL Server to accept incoming connections.
1. Open Security Center from your computer's Start menu control panel.

2. Select to manage security settings for Windows Firewall. The firewall configuration dialog
will appear.
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3. In the Exceptions tab, click Add Programs.

4. Click the browse button.
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5. Navigate to the location of the program to which you want to grant access through your
firewall.
For SQL 2000:
The default location of the file is:
C:\Program Files\Microsoft SQL Server\MSSQL\Binn\sqlservr.exe
For SQL 2005:
You will need to open up two files the default locations are:
C:\Program Files\Microsoft SQL Server\90\Shared\sqlbrowser.exe
and C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Binn\sqlservr.exe
6. Click through the prompts to finish managing your firewall.
Configure SQL Server 2005 to Accept Remote Connections
If you plan on installing Specify on any machine other than the machine you install your data
server on, you will need to enable SQL Server 2005 Express to accept remote connections.

1. Open the SQL Server Configuration Manager. You can find it in your start menu under all
programs and then SQL Server 2005.
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2. If SQL Server Browser has a red square, instead of a green triangle, next to it, then you
will need to change it to start automatically. Right click on "SQL Server Browser".

3. Select the "Service" tab and change "Start Mode" to "Automatic".
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4. Click Apply, then click OK.
5. Expand "SQL Server 2005 Network Configuration" and then select "Protocols for
SQLEXPRESS". Make sure that all protocols are enabled, if they are not, right-click and
select enable.

6. Restart your server and SQL browser to finish.
Updating MSDE
1. Open a web browser (Internet Explorer, Firefox, etc.) and typing in the URL:
http://msdn.microsoft.com/vstudio/express/sql/download/

2. If a message indicating you need to install Microsoft .NET framework 2.0 pops up,
continue with step 3. If not, go to step 12.
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3. Open a new browser window and type in the URL: http://msdn2.microsoft.com/enus/netframework/aa731542.aspx. Select Download x86 version of the .NET Framework
Version 2.0 Redistributable Package.

4. Click Download.
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5. When the download has completed start the dotnetfx.exe file.

6. The installer will extract the files it needs.

7. When the installer begins, you will see this opening dialog, click Next.

23

Specify 5.2 Installation and Setup Guide
8. Read and Accept the End-User License Agreement, then click Install at the bottom of the
screen.

9. You will see several progress dialogs as the .NET 2.0 framework is installed. Installation
may take several minutes.
10. When the .NET installer has finished, Click Finish.
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11. Now go back to http://msdn.microsoft.com/vstudio/express/download/ and download SQL
Server 2005 Express and SQL Server Management Studio Express. Please note that if
you have a 64-bit edition of Windows the Management Studio installer is located just
above the "Need Help?" heading.

12. After the files are downloaded, click the SQLEXPR32 file to start it.

13. The installer will extract the files it needs to a temporary directory.
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14. Read and Accept the End-User License Agreement, then click Next.

15. A dialog will appear giving you a summary of the required components to install. Click
Install. After it has completed, click Next.
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16. The next interactive dialog will be this one, click Next to continue.

17. The installer will perform a system check, if any of the parts fail, you will need to address
them.
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18. You will now see another progress dialog.
19. The registration information dialog is next. Make sure you uncheck the "Hide
advanced configuration options" box!

20. This is another important dialog; make sure you select to install "Client Components".
You will need them to use the Specify web interface.
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21. Now, you need to change the named instance on this dialog to "SPECIFY" (either type it
in or select it by going through the installed instances dialog). This is the step that allows
you to just upgrade your existing data server instead of installing two.

22. At the next dialog, click the check box next to the SQL Server Database Services
8.xx.xxx and then click Next.
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23. Select SQL Server Authentication mode and use your 'sa' credentials and click Next. If
the installer will not let you use this method, you can use Windows Authentication Mode.

24. A dialog will appear to give you an idea of the analysis progress.
25. If you already have a domain user set up to run SQL Server, use those credentials here.
If you do not, most MSDE users will not, use Local system. Make sure that the SQL
Browser check box is selected and click Next.
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26. Enable user instances at this next dialog. You do not need to check the other box unless
you are using Windows Vista. Then click Next.

27. You can click Next at this dialog, unless you have a desire to send reports to Microsoft.
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28. Now you are ready to install SQL Server 2005 Express, click Install.

29. The installer will run through its components.
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30. After the installer finishes, you will see a summary. Click Finish.

31. Next up is the SQL Server Management Studio. Double-click the
SQLServer2005_SSMSEE icon.
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32. The opening dialog will appear.

33. Followed by the License Agreement.
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34. Next, enter your registration information and click Next.

35. You can click Next at the Feature Selection dialog.
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36. The management studio installer will let you know it is ready to install. Click Install to do so.

37. As the installer works you will see its progress.
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38. When the Management Studio installer completes it will show this dialog.

39. Now start up Specify and log into your database to verify that everything is still working. If
it is, then you are done.
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Install Specify
Install Specify
Download the Specify installer, you can find it in the downloads section of the Specify web site
at: http://www.specifysoftware.org.
1. Double-click the Specify Installer icon to begin the installation (Specify Installer.exe). A
splash screen will display a progress bar as the necessary files are extracted.

2. Click Next on the welcome screen to continue.
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3. Read and Accept the Specify License Agreement by clicking Yes at the bottom of the
screen. You can print the license agreement for easier reading and future reference.

4. Enter your name and your company's name in the Customer Information screen.
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5. Next, select an installation location. Specify recommends using the default location.

6. Review your installation settings before moving on. Click Next.
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7. A progress bar will appear. Installation may take several minutes.

8. After the files have been copied to your machine, you will be asked if you would like to
view the readme file. This file contains information about changes made to Specify 5.2
and known issues.

9. The completion of the Specify 5.2 installation process is then confirmed.

10. To Attach a database, refer to Attach a Database in the Setup Procedures section of this
guide.
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DiGIR
DiGIR
The Distributed Generic Information Retrieval protocol, otherwise known as “DiGIR” is a
biological collections community software standard for querying and retrieving specimen data
in a structured (XML) format. Specimen data exchanged in XML has an advantage over
HTML-formatted specimen records in that it can be easily used by other software applications
for analytical or synthesis applications.
Specify's DiGIR package lets your database participate in a DiGIR community network such as
HerpNET or MaNIS. The Specify DiGIR Installer configures a DiGIR provider for your Specify
system and also installs other tools you’ll need to run DiGIR, including the Apache web server
and the scripting language PHP. This Help page shows you how to set up your Specify system
to interoperate with DiGIR.
The purpose of a DiGIR provider is to translate Specify queries from the standard, simplified
format used on a DiGIR network to the local format of a participating collection database. An
example of a unified schema is the Darwin Core. The Darwin Core is a standard set of
parameters describing a natural history specimen. DiGIR lets a client request data from the
community using the universal Darwin Core schema. A DiGIR provider for each database then
translates the query to and from the database’s local schema.
You can install only one DiGIR provider for each Specify database.
The DiGIR query from the client typically is received by a DiGIR Portal. The DiGIR portal is a
web server that manages the communication with DiGIR providers within the community. The
portal maintains a file that lists the network addresses of all DiGIR providers. The portal
receives the query from the client and transmits the query to the providers on the address list.
The query is received by an Apache web server that is part of the DiGIR provider
implementation. The web server invokes various interrelated PHP scripts that translate the
query to a format compatible with the local system and accesses a special, read-only DiGIR
database that is generated from the collection database. The result is then passed back to the
Apache server and forwarded to the portal.
The task of generating the DiGIR data requires additional input from the Specify Project. Your
DiGIR implementation will not be operational until you receive a custom DiGIR query from
Specify. The Specify Project attempts to fill query requests within seven days of the request
date.
The installation instructions for DiGIR gives you the software to run DiGIR with Specify, but it
does not prepare the Specify data for the DiGIR system. DiGIR does not access the Specify
database directly. Instead, it uses a special, read-only database generated from the Specify
data. Once you have installed DiGIR, you will need to initiate the process of creating and
exporting a read-only DiGIR copy of your Specify database. To see how to initiate and set up
DiGIR for your Specify database, refer to the DiGIR section in the Specify 5.2 Help manual.
Complete DiGIR Installation
The Specify DiGIR Package has the capability to automatically set up your DiGIR installation
including a web server (Apache 2.0) and PHP (PHP 4). We cannot guarantee the security or
reliability of either of these 3rd party software distributions. Please use this setup with caution.
1. Download the Specify DiGIR Provider Package. You can find it in the downloads section
on the Specify web site located at: http://www.specifysoftware.org.
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2. Double-click on the installer icon to begin the installation. A splash screen will display a
progress bar as the necessary files are extracted.

3. Click Next on the welcome screen to continue.
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4. The installer will warn you of the security implications of setting up a web server, and
some precautions you or your IT staff should take.

5. Read and Accept the DiGIR License Agreement. You can print the license agreement for
easier reading and future reference.
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6. You will then be presented with a Setup Type dialog. Select everything and set the
destination for your DiGIR provider code. Specify recommends the default setting.

7. A progress bar will appear. Installation may take a few minutes.
8. Like DiGIR, you will have an opportunity to read the PHP license. You must accept the
terms to continue.
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9. You will also need to read and accept the Apache license terms.

10. This dialog allows you to set the destination path for Apache. Specify recommends the
default setting.
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11. The next screen lets you set up your Apache installation. If your machine has a DNS
name, such as if it is part of a domain, enter it in the first box. The DNS Domain would be
the domain your server is on, or just the ip address of your machine. Finally, the web
server administrator email should be the email address of the person in charge of server
maintenance.

12. Again, you will see a bar indicating the Apache installation progress.

13. You will be notified when the Apache installer has finished. It is normal to see some
dialog bleed- through while Apache is installing.
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14. A short blurb about PHP comes up next, click next to have the installer configure PHP to
work with Apache.

15. When the installation is complete, this dialog will appear.
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16. After the installation has completed, an internet browser window will open. You will want
to check to make sure that everything was installed correctly. Click each of the links to
ensure that the pages match up.

17. Clicking on the Apache link should bring up a page that has the words "It works!" or a
page stating that installation was successful.
18. Clicking the PHP link should bring up a page that looks like this one.
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19. Finally, clicking on the DiGIR link should bring up a page of DiGIR related XML data
similar to this one.

Install DiGIR Provider Code
For a manual installation of DiGIR, you will want to use the installer to only install the DiGIR
provider code. Follow these instructions to do so after you install a web server and PHP.
1. Download the Specify DiGIR Provider Package. You can find it in the downloads section
on the Specify web site located at: http://www.specifysoftware.org.

50

Installation
2. Double-click on the installer icon to begin the installation. A splash screen will display a
progress bar as the necessary files are extracted.

3. Click Next on the welcome screen to continue.
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4. The installer will warn you that there are some things to consider about setting up a web
server, and some precautions you should take.

5. You will next see and have an opportunity to read the DiGIR license.
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6. You will then be given a setup type dialog, select "Only DiGIR" and set the destination for
your DiGIR provider code. Specify recommends the default setting. Click Next.

7. Next, you will see a progress bar giving you an idea of how much time is left to copy files.
8. When the installation is complete, this dialog will appear. Click Finish to complete
installation.
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Install and Configure a Web Server
If you chose not to install Apache (the default web server) with the DiGIR installation, you will
now need to install a web server. There are two main options and various versions. Again,
you need to be aware of the security implications of setting up a web server and do this in
collaboration with institutional IT staff. Provided are instructions for using IIS (5, 6, or 7) and
Apache (2.0.x and 2.2.x).
IIS
If you would like to use Internet Information Services (IIS), please select the version you will be
using. IIS 5 is used on Windows XP machines, IIS 6 with Windows 2003, and IIS 7 for
Windows Vista. In all cases, you will be required to install IIS and then set up a virtual
directory.
Installing IIS 5 or 6
Installation for IIS 5 and 6 follows the same steps with the exception of several added steps at
the end to the virtual directory set up for IIS 6 users. Both users can follow the following steps
until that point. Windows XP users follow IIS 5 instructions. Windows 2003 users follow IIS 6
instructions.
To Set Up IIS 5 or 6
1. Insert your Windows CD into your computer's CD drive. If it does not autorun, open up
the CD folder and select setup.
2. Select to install optional Windows Components.
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3. Select "Internet Information Services (IIS)" and click next. If you are using Windows 2003,
it will be called "Application Server".

4. A progress dialog will appear. Installation may take a few minutes.
5. A completion dialog confirms the installation of IIS. Click Finish.
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Set up DiGIR Virtual Directories
1. Open Administrative Tools in Control Panel and select "Internet Information Services".

2. Right-Click on your web site name, and select New -> Virtual Directory.
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3. The Virtual Directory creation wizard will appear. Click Next.

4. Enter the alias name "digir" for this virtual directory.
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5. Now enter the path to the directory. The default path created by the DiGIR installer is:
"C:\Program Files\Specify\DiGIR\DiGIRprov\www"

6. Next, set the permissions for the virtual directory. Select "Read" and "Execute (such as
ISAPI applications or CGI)".
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7. The wizard will finish and you will now be ready to serve content from
http://localhost/digir/ which points to the directory C:\Program
Files\Specify\DiGIR\DiGIRprov\www on your local machine.

8. Click Finish. IIS 5 set up is complete. For IIS 6, please continue.
Note: Windows XP Pro IIS 5.1 does not have the functionality included to restrict
directory access by ip address so there is no need for IIS 5 users to set up a virtual
directory for the admin folder.
For IIS 6 users
9. Now that you have the "digir" virtual directory set up, it is time to set up the admin
directory. Right-click on the "digir" virtual directory and select New -> Virtual Directory.
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10. Again, the Virtual Directory Creation Wizard will appear.

11. Enter the alias name: "admin" for this virtual directory.
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12. Now enter the path to the directory. The default path created by the DiGIR installer is:
"C:\Program Files\Specify\DiGIR\DiGIRprov\admin"

13. Next, set the permissions for the virtual directory. Select "Read" and "Execute (such as
ISAPI applications or CGI)".
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14. Now the "admin" virtual directory has been created. It still needs to be set up to only
accept connections from the local machine.

15. Right-click on the "admin" virtual directory and select properties.
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16. Select the "Directory Security" tab.

17. Select to edit the IP address and domain name restrictions.
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18. Change the default access to Denied and add an exception for IP address 127.0.0.1.

19. Apply your changes and restart your server to finish.
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Installing IIS 7
For Windows Vista users
1. Click the start button and select Control Panel.

2. Select "Programs" from the Control Panel.
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3. Next, select "Turn Windows features on or off".

4. You may need to give windows permission to add new features.
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5. Select "Internet Information Services". When you do, some additional features will be
selected. These defaults are fine, but you will also need to turn on "ISAPI Extensions"
and "ISAPI Filters". Under "Internet Information Services" -> "World Wide Web Service" > "Application Development Features".

6. Windows Vista will install IIS now. You will see this dialog. When it is finished, you will be
able to use IIS.
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Set up DiGIR Virtual Directories
1. Open Administrative Tools in Control Panel and double click "Internet Information
Services".

2. Right-Click on your web site name, and select Add Virtual Directory.
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3. Enter the alias name: "digir" for this virtual directory.
Now enter the path to the directory. The default path created by the DiGIR installer is:
"C:\Program Files\Specify\DiGIR\DiGIRprov\www"

4. Click OK to apply your changes and restart your server to finish.

Apache
Apache server currently has two actively developed versions, Apache 2.0.x and Apache 2.2.x.
If you are performing a fresh install, Apache recommends that you use version 2.2.x. However,
an existing version of Apache 2.0.x works with Specify as well.
Both versions of Apache require two steps for complete installation, the installation of Apache
and the set up a virtual directory.
Apache 2.0.x or 2.2.x
Installation for Apache 2.0 and 2.2 follow the same steps with the exception of the location of
the installer in the first step. Users of both versions can follow the same instructions for
installation of Apache and setting up virtual directories.
To Set up Apache
1. For Apache 2.0
Download the latest Apache 2.0.x installer from http://apache.org. You will most likely
want to download the Windows MSI installer. At the time this document was created,
the latest version of Apache 2.0 was 2.0.59.
For Apache 2.2
Download the latest Apache 2.2.x installer from http://apache.org. You will most likely
want to download the Windows MSI installer. At the time this document was created,
the latest version of Apache 2.2 was 2.2.3.

69

Specify 5.2 Installation and Setup Guide
2. Double-click on the installer icon to begin the installation. The Apache welcome screen
appears. Click Next to continue.

3. Read and Accept the Apache 2.0 License Agreement. Click Next.
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4. The Apache 2.0 installer includes a "read this first" dialog that comes up next.

5. The next dialog helps you configure your server. Enter your network domain in the first
box (if you are unsure, use localhost). The second box is for your server name (DNS
name for your machine or your ip address). Then enter the server administrator's email
address in the third box and click "Next".
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6. Next, select your setup type. Specify recommends using the Typical installation.

7. Select the location where you would like Apache 2 to be installed. Specify recommends
using the default location.
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8. The Apache 2.0 installer notifies you that it is ready to install the product. Click "Install" to
continue.

9. A progress bar appears. Installation may take a few minutes.
10. A completion dialog confirms installation completion.
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Set up virtual directories
1. Open the Apache configuration file with a text editor. By default it is located at:
"C:\Program Files\Apache Group\conf\httpd.conf".
2. Scroll to the bottom of the file and add the following lines. If you used a different path for
your DiGIR installation, alter accordingly.
Alias /digir/admin "C:/Program Files/Specify/DiGIR/DiGIRprov/admin"
<Directory "C:/Program Files/Specify/DiGIR/DiGIRprov/admin">
AllowOverride None
Order deny,allow
Deny from all
Allow from 127.0.0.1
DirectoryIndex index.html, index.php
</Directory>
Alias /digir "C:/Program Files/Specify/DiGIR/DiGIRprov/www"
<Directory "C:/Program Files/Specify/DiGIR/DiGIRprov/www">
AllowOverride None
Order allow,deny
Allow from all
DirectoryIndex index.html, index.php
</Directory>
3. Restart your Apache Server.
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4. Open a web browser and navigate to: http://localhost/digir/ to check that your Virtual
Directories are set up correctly.

Configure PHP
The DiGIR provider code is written in the scripting language PHP. There are currently two
actively developed versions of PHP. They are PHP 4 and PHP 5. Either one will work with the
DiGIR provider code, but PHP 4 is recommended. The current version of the DiGIR provider
code was written to use PHP 4, which is not object-oriented. There are patches that you can
apply to use PHP 5 if you would like, but you will have several warning messages in your
DiGIR.php file.
Installing PHP 4
1. Go to the PHP downloads site: http://www.php.net/downloads.php and download the
latest version of PHP 4. At the time this document was created, the latest version was
PHP 4.4.4. Specify recommends downloading the zip package. The installer can
automatically configure PHP to work with IIS, but it does not include any external
extensions.
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2. Extract the files to C:\. When that is completed, change the name of folder "C:\php-4.4.4Win32" to "C:\php".

3. Copy the file "php4ts.dll" to "C:\WINDOWS\system32\".
4. Now you must choose which server you will use to configure PHP 4.
• Apache 2.0.x or 2.2.x
• IIS 5.1 (Windows XP) or IIS 6 (Windows 2003)
• IIS 7 (Windows Vista)
Configure with Apache 2.0.x or 2.2.x
The following instructions can be used for both Apache 2.0.x and 2.2.x with the exception of a
few steps, which require slight differences in location or name. These instances are set in bold.
1. For Apache 2.0.x, copy the file "C:\php\sapi\php4apache2.dll" to "C:\php\".
For Apache 2.2.x, you will need to get the file "php4apache2_2.dll" from the Specify
website at: http://www.specifysoftware.org/specifyforums/procedures. Save this file to:
"C:\php\php4apache2_2.dll".
2. For both versions, rename the file "php.ini-recommended" to "php.ini" and copy it to
"C:\WINDOWS\" or wherever your Windows installation is.
3. Open the file with a text editor (such as notepad).
4. Search in the file for "doc_root =", and add the path to your htdocs file. If you installed
Apache to the default location, then for Apache 2.0.x, you will use "C:\Program
Files\Apache Group\Apache2\htdocs".
For Apache 2.2.x, you will use "C:\Program Files\Apache Software
Foundation\Apache2.2\htdocs".
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5. A few lines below "doc_root" is "extension_dir". Set it to (assuming default installation
location): "C:/php/extensions".

6. Next, scroll down until you get to the extensions section. Remove the leading semicolons from the lines "extension=php_mbstring.dll" and "extension=php_sockets.dll".

7. Save the file.
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8. Open the file "httpd.conf" with a text editor. The default location for Apache 2.0.x is:
"C:\Program Files\Apache Group\Apache2\conf\"
For Apache 2.2.x, it is "C:\Program Files\Apache Group\Apache2.2\conf\"
9. Scroll down to the end of the LoadModule section, add the following line:
For 2.0.x: LoadModule php4_module "C:/php/php4apache2.dll"
For 2.2.x the file (in the same location) will be named: LoadModule php4_module
"C:/php/php4apache2_2.dll"

10. For 2.0.x: Scroll to the very end of the file and add the following line:
AddType application/x-httpd-php .php

For 2.2.x: Search for the string "<IfModule mime_module>", scroll to the other AddTypes
and add the following line:
AddType application/x-httpd-php .php
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11. Save and close the file.
12. Right-click the Apache icon at the bottom right of your screen and select "Open Apache
Monitor".

13. Click restart in the Apache Monitor.

14. Go to your web home directory for 2.0.x: (C:\Program Files\Apache
Group\Apache2\htdocs\) or for 2.2.x: (C:\Program Files\Apache Software
Foundation\Apache2.2\htdocs\) and create a file named "index.php". Open this file with a
text editor.
15. Set the contents of the file to be:
<?php
phpinfo();
?>
and save the file.
16. To test that configuration was successful, open a web browser and navigate to
http://localhost/index.php.
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Configure with IIS 5.1 (Windows XP) or IIS 6 (Windows 2003)
The following instructions can be used for both IIS 5.1 and IIS 6 with the exception of one step
in which a file uses a different name and several additional steps at the end for IIS 6 users.
The difference is set in bold.
1. Copy the file "C:\php\php.ini-recommended" and rename it to "C:\WINDOWS\php.ini".
2. Open "C:\WINDOWS\php.ini" with a text editor.
3. Change extension_dir to "C:/php/extensions/".

4. Remove the semi-colon from the lines "extension=php_mbstring.dll" and
"extension=php_sockets.dll".

5. Save the file.
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6. Open Administrative Tools from the Control Panel and for IIS 5.1: Select "Internet
Information Services",
For IIS 6 the file will be named "Internet Information Services (IIS) Manager".

7. Right-click on your website name and select properties (if this is your first time here it
should be "Default Web Site").
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8. This dialog will appear, click the "Home Directory" tab.

9. Now click the "Configuration" button.
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10. Add a new application mapping.
11. Use the path:
"C:\php\sapi\php4isapi.dll"
for the executable path and the extension ".php". Click OK until you are back at the IIS
starting screen.

12. For IIS 5.1: Restart the server. You are finished
For IIS 6: Continue on.
For IIS 6 users only:
13. Select "Web Service Extensions" from the left menu pane.
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14. Select to "Add a new Web service extension...".
15. Enter the extension name "php" and make sure that the file "C:\php\sapi\php4isapi.dll"
has been added. Finally, check the "Set extension status to Allowed" box.

16. Restart the server.
Configure with IIS 7 (Windows Vista)
1. Copy the file "C:\php\php.ini-recommended" and rename it to "C:\WINDOWS\php.ini".
2. Open "C:\WINDOWS\php.ini" with a text editor.
3. Change extension_dir to "C:/php/extensions/".
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4. Remove the semi-colon from the lines "extension=php_mbstring.dll" and
"extension=php_sockets.dll".

5. Save the file.
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6. Open Administrative Tools from the Control Panel and select "Internet Information
Services (IIS) Manager".

7. Double-click "ISAPI Filters".
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8. Click "Add..." to add a new ISAPI Filter.

9. Add an isapi filter named "php", point it to "C:\php\sapi\php4isapi.dll".
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10. Return to the main IIS 7 dialog and select "Handler Mappings".

11. Select "Add Script Map...".
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12. Add a script map for "*.php" that points to "C:\php\sapi\php4isapi.dll" and name it "php".

13. Restart the server.
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Installing PHP 5
1. Go to the PHP downloads site: http://www.php.net/downloads.php and download the
latest version of PHP 5. At the time this was written, the latest version was PHP 5.2.0.
Specify recommends downloading the zip package. The installer can automatically
configure php to work with IIS, but it does not include any external extensions.
2. Extract the files to C:\php\.

3. Copy the file "C:\php\php5ts.dll" to "C:\WINDOWS\system32\".
4. You will need to replace some of the libraries distributed with the Specify DiGIR package.
The first is XPath. Download version 3.5 or later from
http://sourceforge.net/projects/phpxpath/. If you installed DiGIR in the default location,
replace the file "C:\Program Files\Specify\DiGIR\DiGIRprov\lib\XPath\XPath.class.php"
with the new version.
5. The second item to update is the "C:\Program Files\Specify\DiGIR\DiGIRprov\lib\adodb"
folder. Replace it with the latest version available from http://adodb.sourceforge.net.
6. Please note that at this time you will receive several warning messages when trying to
use DiGIR with php5. You can ignore these, DiGIR will still operate.
7. Now you must choose which server you will use to configure PHP 4.
• Apache 2.0.x or 2.2.x
• IIS 5.1 (Windows XP) or IIS 6 (Windows 2003)
• IIS 7 (Windows Vista)
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Configure with Apache 2.0.x or 2.2.x
The following instructions can be used for both Apache 2.0.x and 2.2.x with the exception of a
few steps that require slight differences in location or name. These instances are set in bold.
1. Rename the file "php.ini-recommended" to "php.ini" and copy it to "C:\WINDOWS\" or
wherever your Windows installation is.
2. Open the file with a text editor (such as notepad).
3. Search in the file for "register_long_arrays". Turn this on.

4. Search in the file for "doc_root =", and add the path to your htdocs file. If you installed
Apache to the default location, then for Apache 2.0.x, use "C:\Program Files\Apache
Group\Apache2\htdocs".
For Apache 2.2.x, you will use "C:\Program Files\Apache Software
Foundation\Apache2.2\htdocs".
5. A few lines below "doc_root" is "extension_dir". Set it to (assuming default installation
location): "C:/php/ext/".
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6. Next, scroll down till you get to the extensions section. Remove the leading semi-colons
from the lines "extension=php_mbstring.dll" and "extension=php_sockets.dll".

7. Save the file.
8. Open the file "httpd.conf" with a text editor. The default location for Apache 2.0.x is:
"C:\Program Files\Apache Group\Apache2\conf\". For Apache 2.2.x, it is "C:\Program
Files\Apache Group\Apache2.2\conf\"
9. Scroll down to the end of the LoadModule section, add the following line:
For 2.0.x: LoadModule php5_module "C:/php/php5apache2.dll"
For 2.2.x the file (in the same location) will be named: LoadModule php5_module
"C:/php/php5apache2_2.dll".
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10. For 2.0.x: Scroll to the very end of the file and add the following line:
AddType application/x-httpd-php .php

For 2.2.x: Search for the string "<IfModule mime_module>", scroll to the other AddTypes
and add the following line:
AddType application/x-httpd-php .php

11. Save and close the file.
12. Right-click the Apache icon at the bottom right of your screen and select "Open Apache
Monitor".
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13. Click restart in the Apache Monitor.

14. Go to your web home directory for 2.0.x: (C:\Program Files\Apache
Group\Apache2\htdocs\) or for 2.2.x: (C:\Program Files\Apache Software
Foundation\Apache2.2\htdocs\) and create a file named "index.php". Open this file with a
text editor.
15. Set the contents of the file to be:
<?php
phpinfo();
?>
and save the file.
16. To test that configuration was successfulOpen a web browser and navigate to
http://localhost/index.php.
Configure with IIS 5.1 (Windows XP) or IIS 6 (Windows 2003)
The following instructions can be used for both IIS 5.1 and IIS 6 with the exception of one step
in which a file uses a different name and several additional steps at the end for IIS 6 users.
These divergences are set in bold.

1. Copy the file "C:\php\php.ini-recommended" and rename it to "C:\WINDOWS\php.ini".
2. Open "C:\WINDOWS\php.ini" with a text editor.
3. Search in the file for "register_long_arrays". Turn this on.
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4. Change extension_dir to "C:/php/ext/".

5. Remove the semi-colon from the lines "extension=php_mbstring.dll" and
"extension=php_sockets.dll".

6. Save the file.
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7. Open Administrative Tools from the Control Panel and for IIS 5.1: Select "Internet
Information Services", For IIS 6 the file will be named "Internet Information Services (IIS)
Manager".

8. Right-click on your website name and select properties (if this is your first time here it
should be "Default Web Site").
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9. This dialog will appear, click the "Home Directory" tab.

10. Now click the "Configuration" button.
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11. Add a new application mapping.

12. Use the path:
"C:\php\php5isapi.dll"
for the executable path and the extension ".php". Click OK until you are back at the IIS
starting screen.

13. For IIS 5.1: Restart the server. You are finished
For IIS 6: Continue on.
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For IIS 6 users only:
14. Select "Web Service Extensions" from the left menu pane.

15. Select to "Add a new Web service extension...".
16. Enter the extension name "php" and make sure that the file "C:\php\php5isapi.dll" is
included. Finally, check the "Set extension status to Allowed" box.

17. Restart the server.
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Configure with IIS 7 (Windows Vista)
1. Copy the file "C:\php\php.ini-recommended" and rename it to "C:\WINDOWS\php.ini".
2. Open "C:\WINDOWS\php.ini" with a text editor.
3. Search in the file for "register_long_arrays". Turn this on.

4. Change extension_dir to "C:/php/ext/".

5. Remove the semi-colon from the lines "extension=php_mbstring.dll" and
"extension=php_sockets.dll".

6. Save the file.
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7. Open Administrative Tools from the Control Panel and select "Internet Information
Services (IIS) Manager".

8. Double-click "ISAPI Filters".
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9. Click "Add..." to add a new ISAPI Filter.

10. Add an isapi filter named "php", point it to "C:\php\php5isapi.dll".
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11. Return to the main IIS 7 dialog and select "Handler Mappings".

12. Select "Add Script Map...".
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13. Add a script map for "*.php" that points to "C:\php\php5isapi.dll" and name it "php".

14. Restart the server.
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Web Interface
With the release of Specify 5.2, the Web Interface received a facelift. The new
interface combines Java Server Pages with Java Beans and Cascading Style Sheets to
provide you with a powerful new solution to sharing your collection data on the web.
Performance is the key enhancement with this release. Now, the web interface takes
advantage of the Express Search tables introduced in Specify 5.0 producing result sets
much faster than previous versions.
Under the control of CSS (Cascading Style Sheets) the style of your Specify web
pages can be customized for a large number of attributes, and they can be designed to
match your institutional web site’s look and feel. Also, the Google-like Specify Express
Search query box may be placed on any web page on your collection’s web site, not just
on the default Specify query page.
Several often-requested features have been incorporated including support for image
files. If you have a web or file URL value in your Specify database for an image link, the
image will be displayed as a thumbnail or icon (your preference) on the web query results
page. Web users can Click on the thumbnail or icon and bring up the full-sized image.
Specify web sites can also display URL links to external web sources with information
related to the record (e.g. to FishBase or Genbank), or any other multimedia file (e.g.
video, sounds) stored on your database computer. All “http://” references in your data
records display in the web query result pages as active URL links. But images are not the
limit! You can link out to other authority sites for more information about a record, or you
can link to any type of media. All the user has to do is click and they can see a full-size
image of a specimen, read an article about the record, or watch a video from your
collecting event!
Web users of your database also benefit from our customizable web architecture.
They can change display parameters for viewing the results of searches, including such
things as font size and the number of data records displayed on a single web page.
Sorting web data tables resulting from queries by column takes just a mouse click on the
column name header. Also, multiple columns for taxonomic and geographic data values
smartly sort with sort orders cascading from the most inclusive to the least inclusive
column. For example, if a web user sorts a query result table on family names, generic
names automatically sort alphabetically within families and likewise species epithets
within genera.
Other new features are the single box for searching all fields. There is still an
advanced search page for searching individual fields or constructing complex searches.
Each field has its own caption that is strictly used for the web. If you use a name for a
field in-house that may not make sense to the outside world, you can change the caption
so everyone will understand. You can also add field notes to give your users more
information about a field when searching.
We did not limit the improvements to what you can show your users; we gave them
new functionality as well. Search terms are highlighted and results can be sorted after
they are returned. They can even be downloaded in three different formats. We also
added a detail page to view complete information about a record. There is even a stats
page, that you can password protect, for you to see who is accessing your collection and
what they are searching for.
Finally, site administrators also benefit from Specify 5.2’s re-engineered web
interface. To track internet usage of your collection’s data, the new Specify web interface
implements a web page to summarize and analyze your web activity logs. Web usage
statistics can be obtained for the entire duration of your logging period or through custom
searches of specific time periods of the logs. Summary usage tables highlight frequent
search terms and frequent web users. This new capability will be useful for administrators
and collections managers for analyzing activity and trends of collection data queries,
views and downloads.
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There are many possibilities with the new Specify 5.2 Java Web Interface. And since
the code is written outside of the main Specify application, it can be updated separately.
This allows for new features to be added later without having to completely reinstall
Specify. This also makes it possible to host your web interface on any platform you like.
All you need is an ODBC connection to your database!
There are four main steps to installing your Specify 5.2 Web Interface. They should
be performed in the following order.
1. Install Java. The Specify 5.2 Web Interface is written in Java so you will need to install
some form of Java Runtime Environment to use it. The version used will depend on the
JSP you will be using.
2. Install a JSP Container. The JSP container is a web server that is capable of serving up
JSP pages and Java Servlets. There are instructions for two in this manual and they are
Apache Tomcat and Sun Application Server. Please be aware that there are pros and
cons for each. For Apache Tomcat, it is easy to deploy the web interface, but you will
need to use a text editor to change any part of its configuration. For Sun Application
Server, there is a web based interface for deploying applications and setting up users,
however, you will need to use the command line to create a .war file that will be
deployed. Please note that if you are using Windows Server 2003, you will want to use
Sun Application Server as there appears to be a bug with Tomcat that causes it to crash
every few days when running the Specify Web Interface. Sun Application Server has not
shown this problem, but it may be possible as well. If you notice your web interface going
down repeatedly, please contact us.
3. Configure your Specify Web Interface. This is where you will set up the search you would
like to use and change any of the options that you want to.
4. Server User Setup. This will set up basic authentication for the stats page of your web
interface.
Install Java
1. Go to the Java download site http://java.sun.com/javase/downloads/index.jsp and
download the Java Development Kit (JDK).
2. When the download is finished, close the web browser.
3. Run the JDK installer. The first screen you see will be the Java license.
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4. Read and Accept the License Agreement.

5. You will be presented with some installation options. Specify recommends the default
settings.
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6. Next, you will see the progress of the Java installer as it installs JDK.
7. You will be presented with some installation options for the Java Runtime Environment.
Specify recommends the default settings.

8. Next, you will see the progress of the Java installer.
9. After the installer has finished, you will be presented with a dialog notifying you. Click
Finish to complete the installation.
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Install a JSP Container
While it is possible to use other JSP containers for your web interface, instructions for Apache
Tomcat and Sun Application Server are provided.
Installing Sun Application Server
You only need to install one JSP Container. If you install Sun Application Server you do not
need to install Apache Tomcat, and vice-versa. Installing both will not interfere with Specify,
but it is unnecessary.
1. Go to http://java.sun.com/javaee/downloads/index.jsp and download Sun Java System
Application Server Platform Edition. At the time this document was created the latest
version was 9.0 Update 1. You can find it near the bottom of the page under "Download
the Components Independently".

2. On the next screen, choose the platform you wish to use.
3. When the download is complete, close the web browser.
4. Run the Sun Application Server installer. The file will be named sjsas_pe_9_0_01-p01windows (assuming version 9, update 1, Patch 1. The name will change with the
versions.)
5. As the installer initializes, Java Runtime Environment will be launched.
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6. After the installer has initialized, a welcome screen appears.

7. Read and Accept the license agreement. Click Next.
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8. Pick a destination for the installation. Specify recommends you use the default location,
which is "C:\Sun\AppServer".

9. If the installation directory does not exist, you will be asked if it should be created.
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10. You will be asked where the Java 2 Sun Development Kit (SDK) is located. If you have it
installed on your system, the field should be prepopulated. If the field is not prepopulated,
browse for it on your system. If you have not yet installed the Java Development Kit, you
will need to do so.
Click Next.
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11. Next you will configure the admin settings. You may want to c
hange the "admin" name for security reasons. Selecting the "Don't Prompt" radio button
will allow an admin user to log in once per session to the admin portion of the site without
having to supply a password for each admin function as it is used. Last note, if you plan
on using a second web server that forwards requests to your Sun Application Server,
leave your HTTP port as 8080. If this is the only server you will use, change the port to
80.

12. An options dialog will appear which you can change as required. You will want to choose
to add the bin directory to your Windows PATH and create a Windows service for your
server.
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13. Now that you have all of your options configured, the installer will notify you that it is
ready to install Sun Application Server. Click Install Now.

14. A progress dialog appears. Installation may take a few minutes.
15. A completion dialog confirms completion of SAS installation. Click Start Server. Click
Finish to complete installation.
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Installing Apache Tomcat
You only need to install one JSP Container. If you install Apache Tomcat you do not need to
install Sun Application Server, and vice-versa. Installing both will not interfere with Specify, but
it is unnecessary.
1. Go to http://tomcat.apache.org and download Apache Tomcat. To download, click on the
latest version of Tomcat in the left-hand menu, then go to Binary Distributions > Core.
Click on Windows Service Installer.
2. When the download has finished, close the web browser.
3. Run the installer. The Tomcat Welcome screen will appear.

4. Read and Accept the Apache Tomcat license. Click "I Agree" at the bottom of the screen.
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5. Select the features of Tomcat you wish to install. Expand "Tomcat" and select "Service"
and "Native". Click Next to continue.

6. Now you are ready to select a location for Tomcat. Specify recommends the default
location.
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7. Set the port, user name, and password for your Tomcat installation. If you are using
another web server (such as IIS or Apache) use the port 8080. If Tomcat will be the only
web server you use, select port 80. Finally, enter a password. Click Next to continue.

8. You will need to tell Tomcat where the Java Runtime Environment is located. Most likely,
the installer will populate this. If not, browse to its location.
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9. A progress dialog appears. Installation may take several minutes.
10. A completion dialog confirms completion of Apache Tomcat installation.

11. Finally, you will see the Apache Tomcat Readme. Read through it and close to complete
the installation. Click Finish to complete installation.
Configure the Web Interface
There are four main steps to configuring your Specify 5.2 Web Interface. They should be
performed in the following order:
1.
2.
3.
4.

Create an ODBC Connection
Create a Web Search
Build the Web Cache
Deploy the Web Interface

You may want to alter some styles in the web interface. Those instructions can be found in the
Style Changes section.
If you have a web interface installed already, you can skip Step 1 and go straight to Step 2.
Web searches must receive different names from the previous web searches. All other
aspects of the search can be the same, but the name must be different.

Note: You must delete previous web searches before updating Specify.
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Create an ODBC Connection
The Specify Web Interface requires an ODBC connection to your database. These are the
steps needed to create one. Note that the dialogs will look a little different on other versions of
Windows.
1. Start by opening your machine's control panel. You can find it from the settings menu
option in your start menu.

2. Select "Administrative Tools", note that if your control panel is set up to use category
view, you should go through "Performance and Maintenance" to find "Administrative
Tools", or switch to classic view.

3. Now select "Data Sources (ODBC)".

4. The ODBC dialog will appear, click the "System DSN" tab.
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5. From the System DSN tab, click "Add..." to create a new ODBC connection.

6. Now choose "SQL Server" for the data source driver. Click Finish.
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7. Give the data source a name. This is the name that you will use to configure your web
interface. Also, enter the server name your database is hosted on. You can click the
arrow to select from a list. Click Next.

8. At the next dialog, choose the method you will use to authenticate. If you are using mixed
mode (username and password) then select the second option. Then enter a username
and password of a user that can connect to the database. This example uses a 'sa' user,
but you can use a lesser privileged user for a more secure environment. Click Next.
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9. Change the default database to the one to which you wish to connect (the database with
the data you want to make available in the interface). This example uses the Fishdemo
database. Click Next.

10. There is nothing on the last option screen that needs to be altered. Click Finish.
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11. You will see a summary of the ODBC connection, click "Test Data Source..." to ensure
that the settings are correct.

12. If the test completes successfully, you will see this dialog.

13. Your ODBC connection is now set up, make sure that you use the correct name when
setting up your web interface.
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Create a Web Search
To use the Specify Web Interface, you will first need to create a web search. This search
should include all of the fields you would like web users to see when they browse to your site.
1. Open Specify and create a new search. Do not use a previously saved search or a
default search as these will interfere with the interface's ability to compile data. An
example search is shown in the image below. Several types of fields are shown to
illustrate what can be done with the interface.

2. After you have selected the fields you would like to use for your web interface. Select
Search->Save for Web from the top menu.
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3. Give this search a name.

4. Now that you have saved your web search, you need to configure the web interface.
From the top menu, select Tools -> Admin -> Web Settings.
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5. The web server configuration dialog will appear. Select the web search you created from
the drop-down at the top left.

6. At this point, you can change the display name for any of the columns in the search to
make them clearer for those browsing your site.
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7. You will also need to fill in the fields on the right.
• Collection Title - the text that appears in the banner
• Collection Image - the image in the banner
• The image file is created by the user and should be placed in C:\Program
Files\Specify\Specify\WebFiles\{search name}
• ODBC name - the name of the ODBC connection to your database
• Log Table - the name of the table to keep track of the search log - use "webLog"
unless using multiple web interfaces in which case you may want to use
something more descriptive.

8. Click the Create / Update template button. A confirmation box confirms completion. Click
OK.

9. You have the option of Creating the Web Cache now or later.
To Create the Web Cache now: Click Create/Update Web Cache. Then, Deploy the
Web Interface.
To create the Web Cache later: Exit out of the Web Server Configuration box. When
you want to build the Web Cache go to Build the Web Cache.
Note: The Collection Image can be placed in the destination folder now. The image must be
placed before the web interface is deployed.
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Build the Web Cache
You will need to build the web caches if you want to use the web interface. These tables are
similar to the Express Search tables and allow for very fast searching. There are two methods
to build the cache, but they are very similar.
Note: The web cache must be updated after changes to the database in order for the interface
to reflect the changes.
Method 1
You can build the cache by going through the web settings for a particular web search.
1. In the Specify menu bar, go to Tools -> Admin -> Web Settings menu option.

2. Click the " Create / Update Web Cache" button to start the build.
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3. There are two progress dialogs that appear as Specify creates the web cache tables.
Installation may take several minutes.
4. When Specify has finished creating the cache, this message will be displayed.

5. Now you will need to Deploy the Web Interface.
Method 2
A second option is to build the cache without going through the web settings.

1. In the Specify menu bar, go to Tools -> Admin -> Create / Update Web Cache menu
option.
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2. Select the search you would like to build the cache for and click OK.

3. There are two progress dialogs that appear as Specify creates the web cache tables.
Installation may take several minutes.
4. When Specify has finished creating the cache, this message will be displayed.

5. Now you will need to Deploy the Web Interface.
Deploy the Web Interface
After you have configured and created your web interface files, you will need to deploy them.
Please select your JSP Container for instructions.
You will have to redeploy the web interface any time the template is altered or updated but not
when the cache is updated.
•
•
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Deploy an Application with Sun Application Server
1. You will need to create a .war file that Sun Application Server can deploy as a Web
Application. Start by opening a command prompt (Click the start button and then
Programs -> Accessories -> Command Prompt.

2. Change directories to the directory where your web search was created. If you installed
to the default location, then you would type: "cd C:\Program
Files\Specify\Specify\WebFiles\{search name}". Replace {search name} with the name of
your search.

3. Next, run the java "jar" command to create a .war file. You may have to specify the full
path to the java bin directory. (Tip: use tab to automatically fill in directory information. If
you enter the first few characters of the directory name and press tab, the rest of the
name will be filled in. If you have more than one directory that begins with the characters
you entered, simply press tab again to scroll through). Enter the command: "C:\Program
Files\Java\jdk(press tab to bring up your jdk version directory)\bin\jar -cvf {search
name}.war *".
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4. You will see output like this as your .war file is created.

5. Now, launch a web browser and point it to http://localhost:4848/ where "4848" is the
admin port for Sun Application Server. Login using admin credentials.

6. After logging in, select "Web Applications" under "Applications" from the left menu.

7. Then click the "Deploy" button in the main frame.
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8. Use the browse button to navigate to the location of the .war file you created. It will be
located at: C:\Program Files\Specify\Specify\WebFiles\{search name}\{search name}.war.
Click Next to continue.

9. After uploading your file, you will have a chance to change some parameters if you'd like.
Click Finish when you are done.

10. Finally, check your web interface by navigating to: "http://localhost:8080/{search name}/"
(the search name is case sensitive). Where "8080" is the port number you used for Sun
Application Server and {search name} is the name of your web search. It is case
sensitive so any part capitalized in the file must be capitalized when navigating to it.

11. You can now adjust the display styles of your web interface or Sun Application Server
User Setup.
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Deploy an Application with Apache Tomcat
1. First, navigate to the Specify WebFiles directory. By default, it is located at: "C:\Program
Files\Specify\Specify\WebFiles\".

2. Copy the folder named after your web search. In this example it is named "exampleWeb".
Paste this file into the "webapps" Tomcat directory. By default, it is located at:
"C:\Program Files\Apache Software Foundation\Tomcat 5.5\webapps\".
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3. Next, stop and start Tomcat. You can either do this from the Tomcat icon in your quick
launch menu, or by selecting "Configure Tomcat" from your Windows Start Menu.

Note:If Tomcat will not start it may be due to a file misplacement which occasionally
happens during the installation process. To rectify the issue you need to move the file.
To do this go to the Start Menu and select Search -> For Files or Folders... Then
search for MSVCR71.dll. When the file is located, copy the file and paste it in the
folder labled System32 in the Windows file on the C drive. The name of this folder may
change according to the system the computer uses (such as WinXP).
4. A progress bar will appear notifying you of Tomcat's progress.
5. Finally, check your web interface by navigating to: "http://localhost:8080/{search name}/".
Where "8080" is the port number you used for Tomcat and {search name} is the name of
your web search. It is case sensitive so any part capitalized in the file must be capitalized
when navigating to it.

6. You can now adjust the display styles of your web interface or Apache Tomcat User
Setup.
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Style Changes
There are numerous changes you can make to the look and feel of your Specify Web
Interface. The first few sections below are of images of pages you will find in your web
interface. There is also a list of non-CSS changes possible as well as a little CSS background
information.
Main Grid View
Each of the sections can be customized. Click on the relevant section of the image to find out
more about its customization.
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Detail View
Each of the sections can be customized. Click on the relevant section of the image to find out
more about its customization.

Advanced Search View
Each of the sections below can be customized. Click on the relevant section of the image to
find out more about its customization.
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Stats View
Each of the sections below can be customized. Click on the relevant section of the image to
find out more about its customization.

Non-CSS Changes
There are several non-CSS changes that can be made to your web interface. Some of which
are listed below.
Web Setting Items
•
•
•
•
•
•
•
•

Display Name
Field Order
Field Types
Display
Sortable
Field Info
Detail Order
Multi-Value Fields

Configure.jsp Items
•
•
•
•
•
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Thumbnail Size
Thumbnails vs. Icons
Stats Logging
Maximum Number of Results to Return
Cell Truncate Position
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This first section of Non-CSS Options can be changed in Specify when you set up the web
interface or can be altered afterward.
To access the settings:
1. In the Specify menu bar select Tools -> Admin -> Web Settings.
2. Click on Property to reveal a list of the items to be changed.
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Display Name

Changes the captions displayed in the web interface. This
Description: can be used to clarify what a column is for those outside of
your collection or institution.
Changed through Specify when you set up your interface.
How to Change: Select DisplayName property from the parameters
dropdown list. Select the column and change the value.
Default

Modified

Example:

Field Order

Determines the order in which columns are displayed in the main grid view. By default,
Description: it is determined by the order that you select your columns for your web query, but this
may not be the order that you wish to display them.
How to Open web settings for the query in Specify. Select FieldOrder property from the
parameters dropdown list and change the number order.
Change:
Default

Example:
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Field Types

Determines how data is handled, e.g. images can be
displayed as thumbnails or strings. (This does not affect
Description:
use of thumbnails vs. icons.) This should only be changed
if recommended by Specify.
Through Specify when you set up your interface. Open
web settings for the query in Specify, select FieldType
How to Change:
property from the parameters dropdown list. Select the
column and change the value.
Default
Modified

Example:

Display

Description:
How to
Change:

Determines if fields can be viewed by web users. Fields can be set to never display,
always display, or only display on the detail page.
Open web settings for the query from Specify. Select Display property and change the
value of the relevant field. A value of 1 means the field will be displayed always, 0
means never, and 2 means only on the detail view.
Default
Modified

Example:
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Sortable

Description: Determines which columns can be sorted.
Open web settings for the query From Specify. Select the Sortable property
from the parameters dropdown list and change the value of the relevant
How to Change:
field. A value of 0 means column cannot be sorted and 1 means the column
can.
Default
Modified

Example:

Field Info

Gives the end-user more information about a particular column. For
example, to give an idea of date format required in a field. They are
Description:
provided as tool tips when rolled over the caption of a field in the advanced
search.
Open the web settings for the query in Specify. Select the FieldInfo property
How to Change: from the parameters dropdown list. Enter the text for each column that you
would like displayed as a tool tip.
Default
Modified
Example:
Text displayed on hover:
Genbank link

Text displayed on hover: Link to
Genbank for more information

Detail Order

Description: The order of fields on the detail page.
How to Open the web settings for the query in Specify. Select the DetailOrder property
from the parameters dropdown list and change the number order.
Change:
Default

Example:
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Multi-Value Fields

Displays all of the values of a particular field for a given record in the detail
view. For example, a specimen may have several types of preparations listed.
Description:
If the Preparation field is coded as a multi-value field, the detail view of the
record will show that there is more than one preparation for the record.
Open the web settings for the query in Specify. Select the Multi-Value Fields
How to property from the parameters dropdown list and change the value of the
relevant field. A value of 0 means the field may have multiple values and 1
Change:
means there is only one.
Default
Modified

Example:

Configure.jsp Items
Thumbnail Size

Description:
How to
Change:

Allows you to specify the size of thumbnail images that appear in your
results page.
Modify the variables "thumbnailHeight" and "thumbnailWidth" located near
the beginning of the file "/WEB-INF/jspf/configure.jspf". Open with a text
editor. The values are in pixels.
Default
Modified

Example:

Thumbnails vs. Icons

Description: Allows you to choose the format in which images are displayed.
By default, images are displayed as thumbnails which will display the full
How to size image when clicked. For icons instead, open "/WEBINF/jspf/configure.jspf" with a text editor and modify the variable
Change:
"thumbnails" to false.
Default
Modified
Example:
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Stats Logging

Turns updating the stats page on and off. This information
Description: includes their ip address, date/time searched, search performed,
and search parameters used.
Open "WEB-INF/jspf/configure.jspf" with a text editor and find
How to
the "logging" variable. By default logging is set to "true". To
Change:
turn logging off, set this to "false".
Default
Modified
Example:
Maximum Number of Results to Return

Description: Allows you to change the maximum number of results returned.
Open the file "/WEB-INF/jspf/configure.jspf" and modify
How to
"maxToReturn" to the value you require. Default is 10,000 results
Change:
in order to improve performance on very large databases.
Default
Modified
Example:

Be default a maximum of
The modified code sets the
10,000 results will be returned. maximum to 1 million results.

Cell Truncate Position

Sets the maximum number of characters to display in a cell in the Main Grid
Description: View. The remaining text will be truncated using an ellipses. Full text can still
be read in the Detail View
Open "WEB-INF/jspf/configure.jspf" and find "truncatePosition" variable.
How to
Change the value inside the quotes to the number of characters you would like
Change:
displayed.
Default
Modified
String = "This shows what happens to
Example: a string when the truncate position is
set to 30."
Results in: "This shows what happens
to a s..."

144

String = "This shows what happens to
a string when the truncate position is
set to 60."
Results in: "This shows what happens
to a string when the truncate positi..."
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CSS Colors
CSS, or Cascading Style Sheets, can be used to control the look and feel of your web pages
from a single place. This makes it much easier to change the look of your site and keeps
things consistent with minimal effort. Below are some links that give some background on
different css elements (colors, fonts, and borders). These will help you customize your Specify
Web Interface. If you would like to learn more about CSS, you can either run a web search for
"CSS" or purchase a book on the topic.
Color properties in CSS can be expressed in multiple ways. You can use the color name itself
in some cases, the rgb value, or the hex value. When you look at the stylesheet all of the
values are in hexadecimal format. Hex format looks like this: #rrggbb, where each set of xx
represents the hexadecimal representation for that color value in the order red green blue.
RGB format is: rgb(rrr, ggg, bbb) where rrr represents the value of the red attributed (0 - 255),
ggg for green and bbb for blue. Below is a table of some of the colors.

Name Value RGB Value Hex Value Color
Black
rgb(0, 0, 0)
#000000
Blue
rgb(0,0,255)
#0000FF
Brown
rgb(155, 42, 42) #A52A2A
Cyan
rgb(0, 255, 255) #00FFFF
DarkBlue rgb(0, 0, 121)
#00008B
DarkGrey rgb(159, 159, 159) #A9A9A9
Gold
rgb(255, 215, 0) #FFD700
Grey
rgb(128, 128, 128) #808080
Green
rgb(0, 128, 0)
#008000
Khaki
rgb(240, 230, 140) #F0E68C
Magenta
rgb(255, 0, 255) #FF00FF
Olive
rgb(128, 128, 0) #808000
Orange
rgb(255, 165, 0) #FFA500
Pink
rgb(255, 192, 203) #FFC0CB
Purple
rgb(128, 0, 128) #800080
Red
rgb(255, 0, 0)
#FF0000
Sienna
rgb(160, 82, 45) #A0522D
Tan
rgb(210, 180, 140) #D2B48C
Teal
rgb(0, 128, 128) #008080
Turquoise rgb(64, 224, 208) #40E0D0
Violet
rgb(238, 130, 238) #EE82EE
white
rgb(255, 255, 255) #FFFFFF
Yellow
rgb(255, 0, 0)
#FFFF00
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CSS Fonts
Fonts have several properties that can be set using CSS. The Specify Web Interface does not
set every possible property by default, but you can add the properties that are not present.
Below is a list of widely supported css font properties.
•
•
•
•
•
•

The Color Attribute
The Font-Family Attribute
The Font-Size Attribute
The Font-Style Attribute
The Font-Variant Attribute
The Font-Weight Attribute

The Color Attribute
The "color" attribute is used to specify the color of the text. Please refer to the CSS Colors
page for a reference about colors. The text below uses "color: #FF0000" which produces red
text.
This should be red text.
The Font-Family Attribute
The "font-family" attribute is used to specify the font to be used for the text. However, a
particular font may not be present on the end system so font-family is a prioritized list of fonts.
You should specify the ideal font you would like for an element to be, followed by a list of
acceptable fonts. The last font in the list should be a generic font family since it will be more
widely implemented by the visitor's browser.
In the example below, the font-family attribute is set to: "font-family: Arial, sans-serif;" this will
tell the user's browser to use Arial, but if it does not have Arial use a Sans-Serif font. Note that
if the name of the font family you wish to use has a space, you must put it inside of quotes.
Arial or Sans-Serif
The Font-Size Attribute
"font-size" is the attribute used to set the size of text for a given element. Here are some of the
values along with their result.
•
•
•

font-size: xx-small;

font-size: x-small;

font-size: small;

•

font-size: medium;

•

font-size: large;

•

font-size: x-large;

•
•
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font-size: smaller;
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•

•

•

font-size: larger;

font-size: 50px;

font-size: 380%;

The Font-Style Attribute
There are three values for the "font-style" attribute. They are: normal, italic, and oblique.
• font-style: normal;
• font-style: italic;
• font-style: oblique;
The Font-Variant Attribute
"font-variant" has two possible values, normal and small-caps.
• font-variant: normal;
• FONT-VARIANT: SMALL-CAPS;
The Font-Weight Attribute
"font-weight" determines the weight of the text. This can be expensed in words or numbers.
•
•
•
•
•
•
•
•
•
•
•
•
•

font-weight: normal;
font-weight: bold;
font-weight: bolder;
font-weight: lighter;
font-weight: 100;
font-weight: 200;
font-weight: 300;
font-weight: 400;
font-weight: 500;
font-weight: 600;
font-weight: 700;
font-weight: 800;
font-weight: 900;
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CSS Borders
There are four main border properties that are used with the Specify Web Interface. They are
style, color, width, and collapse. There is more that you can do with borders that is not
described here, you may want to look through a CSS book, or look on the web.
Border Style
The "border-style" attribute refers to the style of border an entity has. There is an
example of each below.

o

border-style: none;

A table with no border
o

border-style: dotted;

A table with a dotted border
o

border-style: dashed;

A table with a dashed border
o

border-style: solid;

A table with a solid border
o

border-style: double;

A table with a double border
o

border-style: groove;

A table with a groove border
o

border-style: ridge;

A table with a ridge border
o

border-style: inset;

A table with an inset border
o

border-style: outset;

A table with an outset border
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Border Color
The "border-color" attribute can be used to specify the color of the border around an
object. It is possible to set the color for each side as demonstrated below. Please note
that you have to specify a border style before setting a color.
o

Setting all sides to the same color
border-style: solid;
border-color: #FF0000;

Border is completely red
o

Setting the color for each side
border-style: solid;
border-left-color: #FF0000;
border-right-color: #0000FF;
border-top-color: #000000;
border-bottom-color: #00FF00;

Each side has a different color border
Border Width
The "border-width" attribute is used to specify the width of the border around an object.
It is possible to set the width for each side as demonstrated below. Please note that
you have to specify a border style before setting a width.
o

Setting all sides to the same width
border-style: solid;
border-width: 2px;

2px wide border
o

Setting the width for each side
border-style: solid;
border-left-width: 1px;
border-right-width: 2px;
border-top-width: 4px;
border-bottom-width: 8px;

Each side has a different width border
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Border Collapse
The "border-collapse" property is used with tables. If it is set to "collapse" then only
one border appears. If it is set to "separate" then both borders appear.

Table border is set to black, data cells have multi-colored borders.
o

Collapse

Cell 1 Cell 2
Cell 3 Cell 4
o

Separate

Cell 1 Cell 2
Cell 3 Cell 4
Below is a list of CSS elements that can be altered in the Specify Web Interface. These
elements can be found in the file "specify.css".

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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Background Color
Banner Bottom Row
Banner Image
Banner Title
Banner Top Row
1-to-1 Relationship Table Cells
Display Options Menu
Download Buttons
Even Stats Row Color
Even Table Row
Navigation Buttons
Odd Sorted Row
Odd Stats Row Color
Odd Table Row
Print Button
Page Information
Regular Table Header
Search Box
Search Hit
Sorted Even Table Row
Sorted Table Header
Stats Menu
1-to-Many Relationship Table Cells

Installation

Background Color

CSS Class:
Description:

body
This is the background color for all of the pages in your web
interface.

Default
Properties:

Banner Bottom Row

td.pageHeaderBottomRowLeft,
td.pageHeaderBottomRowCenter,
CSS Class:
td.pageHeaderBottomRowRight,
td.pageHeaderBottomRowAnchor
This is the bottom row of the banner. There is a left, right,
Description: and center section, as well as a style for the anchor
elements ([Advanced Search] and [Display Options]).

Default
Properties:

Other Changes:
The entire banner can be pulled out if you have your own you would like to use. The file "WEBINF/jspf/banner.jspf" has all of the code for the banner. This is where you would put your own
banner.
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Banner Image

CSS Class:
Description:

td.pageHeaderTopRow
This is the image that is displayed in the banner of your web
interface.

Default
Properties:

How To Change:
This item is changed while configuring your interface for the first time. At that time you have a
chance to enter an image name that will be used in this banner. If you decide to change later,
change the value of the collectionImage parameter, located in the file "WEBINF/jspf/configure.jspf".
Other Changes:
The entire banner can be pulled out if you have your own you would like to use. The file "WEBINF/jspf/banner.jspf" has all of the code for the banner. This is where you would put your own
banner if you want.
Banner Title

CSS Class:
Description:

td.pageHeaderTitleBar
This is the title for your collection that is displayed in the banner.

Default Properties:

How To Change:
This item is changed while configuring your interface for the first time. At that time you have a
chance to enter a collection title that will be used in this banner. If you decide to change later,
change the value of the collectionTitle parameter, located in the file "WEBINF/jspf/configure.jspf".
Other Changes:
The entire banner can be pulled out if you have your own you would like to use. The file "WEBINF/jspf/banner.jspf" has all of the code for the banner. This is where you would put your own
banner if you want.

152

Installation

Banner Top Row

CSS Class:
Description:

td.pageHeaderTitleBar
This is the rest of the top row of your banner.

Default Properties:

Other Changes:
The entire banner can be pulled out if you have your own you would like to use. The file "WEBINF/jspf/banner.jspf" has all of the code for the banner. This is where you would put your own
banner if you want.
1-to-1 Relationship Table Cells

CSS Class: table.consist, th.consist, td.consist
These are the cells in your detail view that have 1-to-1
relationships. This means that they can only have one
Description:
value per record. An example would be field number of the
collection site.

Default
Properties:
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Display Options Menu

.config, .configOpen, .configFont,
CSS Class: .configRowRight, table.configTable,
.configTH
Description: These are all of the css classes associated with the display options menu.

Default
Properties:

Download Buttons

CSS Class:
Description:
Default Properties:
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.downloadResults
These are the download result set buttons.
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Even Stats Row Color

CSS Class: .evenStats
These are even numbered rows on the stats page. Even and
Description: odd rows are alternated to make it easier to distinguish one
row from another.
Default
Properties:

Even Table Row

CSS Class: .even
These are even numbered rows. Even and odd rows are
Description: alternated to make it easier to distinguish one row from
another.
Default
Properties:

Navigation Buttons

CSS Class: .navigate
These are the page navigation buttons. There are buttons to
Description: return to the start of a result set, go to the end of a result set,
go forward one page, and go back one page.
Default
Properties:
Other Changes:
The default navigation buttons can be replaced by some that better fit your site. Replace these
images in the style directory with the ones you would like to use:
•

start.gif -- Button that goes to the beginning of the result set

•

startD.gif -- Disabled version of start.gif

•

back.gif -- Button that goes back in the result set one page

•

backD.gif -- Disabled version of back.gif

•

forward.gif -- Button that goes forward in the result set one page

•

forwardD.gif -- Disabled version of forward.gif

•

finish.gif -- Button that goes to the end of the result set

•

finishD.gif -- Disabled version of finish.gif
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Odd Sorted Row

CSS Class: .oddSorted
These are odd number rows in the sorted columns. Even
and odd rows are alternated to make it easier to distinguish
Description:
one row from another. This class also creates a difference
in columns so the sorted column is highlighted.
Default
Properties:

Odd Stats Row Color

CSS Class: .oddStats
These are odd numbered rows on the stats page. Even and
Description: odd rows are alternated to make it easier to distinguish one
row from another.
Default
Properties:

Odd Table Row

CSS Class: .odd
These are odd numbered rows. Even and odd rows are
Description: alternated to make it easier to distinguish one row from
another.
Default
Properties:

Print Button

CSS Class:
Description:

.downloadResults
This is the print button used to call the command "window.print".

Default Properties:
Other Changes:
You can change the print icon that better fits your site by replacing the file "printerIcon" in the
"style" directory.
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Page Information

CSS Class: .pages
This is the portion of the results page that notifies you
Description: which records you are viewing as well as the total number
of records in the result set.
Default
Properties:

Regular Table Header

CSS Class:
Description:

.thReg
These are normal column headers.

Default Properties:

Search Box

CSS Class: None
This is the search box that is present at the bottom of the
Description: result set. It is also present on the first visit to the page
before a result set is created.
Default
None
Properties:
Other Changes:
You can put a search box on another page on your site. All you need to do is add these
parameters:
•
•
•
•

searchValue -- The value to search for
firstSearch -- Set this to true
firstVisit -- Set this to false
keep -- set this to 0

If you search for the string "kansas" then you need to generate the address:
"specWeb.jsp?searchValue=kansas&firstSearch=true&firstVisit=false&keep=0"
Or you can use this html code (be sure to add the entire URL to specWeb.jsp in the action
section):
<form name="specify" action="specWeb.jsp" method="post">
<input type="text" name="searchValue" />
<input type="hidden" name="firstSearch" value="true" />
<input type="hidden" name="firstVisit" value="false" />
<input type="hidden" name="keep" value="0" />
<input type="submit" value="Search" />
</form>
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Search Hit

CSS Class:
Description:

.searchHit
This is the highlighting for search hits.

Default Properties:

Sorted Even Table Row

CSS Class: .evenSorted
These are even number rows in the sorted columns. Even and odd rows
are alternated to make it easier to distinguish one row from another. This
Description:
class also creates a difference in columns so the sorted column is
highlighted.
Default
Properties:

Sorted Table Header

CSS Class:
Description:

Default Properties:
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.thSorted
This is the column header for the sorted column.
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Stats Menu

CSS Class:
Description:

th.stats, td.stats, table.stats
This is the search window and menu for the stats page.

Default Properties:

1-to-Many Relationship Table Cells

CSS Class: table.variable, td.variable, th.variable
These cells appear below the 1-to-1 cells on the detail page. They can
Description: have multiple values. Examples of these are determinations or
preparations.

Default
Properties:
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Server User Setup
The Server User Setup will set up basic authentication for the stats page of your web interface.
The stats page will only be viewable to authenticated users.
Sun Application Server User Setup
This procedure will set up basic authentication for the stats page of your web interface. Please
note that this is not the most secure method possible as a username and password is passed
via an insecure connection to your server. If you feel that the data revealed in the stats page
needs to be more secure, you may wish to enable Sun Application Server to use an SSL
connection.
1. Begin by starting the Server's admin console. You can do so by opening a web browser
and navigating to the address: "http://localhost:4848/" (if you used the default admin port,
4848).
2. Click the arrow next to "Configuration" on the left menu to expand this item. Do the same
for "Security" and then "Realms". Finally select the "file" realm.

3. Click the "Manager Users..." button.
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4. Click "New" to create a new user. Enter a user ID and password and then enter: "user" in
the "Group List:" box. Then click OK.

5. Restart your machine.
6. After your server has restarted, navigate to the stats page of your web interface. If you
set up Sun Application Server to use port 8080, you can check by entering the address:
"http://localhost:8080/{Search name}/stats.jsp". You should be presented with a login
request dialog. It will be similar to the one in the picture below, but will vary by browser.
Enter the user name and password created in step 4 of this procedure.
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7. After you log in, the stats page will appear.

Apache Tomcat User Setup
This procedure will set up basic authentication for the stats page of your web interface. Please
note that this is not the most secure method possible as a username and password is passed
via an insecure connection to your server. If you feel that the data revealed in the stats page
needs to be more secure, you may wish to enable Tomcat to use an SSL connection.
1. Begin by opening the file "tomcat-users.xml" with a text editor, such as wordpad, located
at "C:\Program Files\Apache Software Foundation\Tomcat 5.5\conf\tomcat-users.xml" or
something similar. You can change what program that you open the file with by rightclicking on the icon and selecting "Open with...". That will bring up a dialog that will allow
you to choose a program to open the file with.
2. Add the line:
<role rolename="loginUser"/>
with the rest of the roles and another line with the users:
<user username="USERNAME" password="PASSWORD" roles="loginUser"/> Substitute
a username for USERNAME and a password for PASSWORD.

3. Save the file.
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4. Now, restart Tomcat by opening the Apache Tomcat Configuration Monitor from the
Windows Start menu and clicking Stop. Then click Start.

5. After your server has restarted, navigate to the stats page of your web interface. If you
set up Tomcat to use port 8080 and used the directory "webInterface" for your web
directory, you can check by entering the address:
"http://localhost:8080/webInterface/stats.jsp". You should be presented with a login
request dialog. It will be similar to the one in the picture below, but will vary by browser.
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6. After you log in, you should see the stats page.

Delete a Web Interface
Deleting a web search will not delete the web interface. Although the interface will no longer
function, the files will still exist at several locations on the computer's hard drive. Leaving the
files will do no harm to your computer other than taking up space. However, if you want to get
rid of the space the following steps will show you how.
There are two steps to deleting a web interface. First, the web search must be deleted in
Specify. Second the web interface files must be deleted in the JSP container.
To Delete a Web Search in Specify:
1. Click on Collection Events under Search and Edit Data in the left-hand menu to open a
search.
2. From the Specify menu bar select Search > Delete.
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3. In the resulting Dialog box select the search to be deleted and click OK to finish.

To Delete The Web Interface Files in the JSP Container:
1. If you are using Sun Application Server:
a. Launch a web browser and point it to http://localhost:4848/ where "4848" is the
admin port for Sun Application Server. Login using admin credentials.
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b. After logging in, select "Web Applications" under "Applications" from the left
hand menu.

c.

Then click the "Undeploy" button in the main frame to finish.

2. If you are using Apache Tomcat:
a. Navigate to the "webapps" Tomcat directory. By default, it is located at:
"C:\Program Files\Apache Software Foundation\Tomcat 5.5\webapps\".

b. Right click on the file associated with the interface to be deleted and select
delete.
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Setup Procedures
Starting Specify
These instructions assume that you have already attached an existing SQL database which is
in the Specify format.
After Installation, there are three scenarios for beginning to use Specify:
1. Attach the demonstration database (see Attach a Database) and begin testing.
2. Attach the Blank database (see Attach a Blank or Fishdemo Database), set up and
customize Specify as described in the Installation Manual, and begin entering your
specimen and transaction data from your legacy system one field at a time. We ask that
you register your collection with the Specify Software Project. To see how to register,
please refer to Becoming a Registered User.
3. Attach a database containing your existing data which has been migrated into the Specify
format. Once you have evaluated Specify and have committed to using it to manage your
collections, we ask that you register your collection with the Specify Software Project - see
Becoming a Registered User. If your registration is accepted, our staff will convert any
existing computerized data into Specify and return it to you. No automated import function
is included in Specify 5.2.
To start the Specify Application:
1. Choose Start > Programs>Specify.
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2. The Specify login screen appears. Enter the server and database name. If you have
already attached a database these should already be filled in. If a database is not
attached, refer to Attach a Database. Databases that have previously been used will be
available in the Database dropdown list.

3. Enter a user name and password for the database you chose in step 2.
4. Click OK. If you are logging into a database from a previous version of Specify, it will take
a few seconds to a few minutes (depending on the size of the database) to update. Click
OK in each of the following dialog boxes.

5. Click the OK button to continue.
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Becoming a Registered User
Anyone may download, install, and operate Specify without a fee after agreeing to the End
User License Agreement presented during the installation process. The Specify Software
Project provides software support and data management services for nonprofit, research
institutions that choose Specify for their primary production system. Specify was designed for
institutional collection databases and is supported for that use only.
The Specify Software Project recognizes two classes of users: evaluation users and registered
users.
Evaluation users may
•
•
•
•

Install unlimited copies of Specify.
Use the technical documents and support features of the Specify Project web site:
http://www.specifysoftware.org
Obtain limited assistance from the Specify Software Project in customizing data entry
forms and report formats, for the purposes of evaluating Specify for use as their
primary departmental or institutional collection database system.
Obtain limited data migration services, technical support, and training for evaluation
purposes.

Registered users are entitled to:
•
•
•
•
•
•
•

Data migration assistance. The Specify Project team will migrate your existing
collection data to Specify at no charge.
Help Desk support. We respond to every request for assistance or information.
Interface customization. We will customize Specify's data entry forms for a registered
institution's exact needs.
Report and label customization. We will create custom report templates for labels, loan
invoices, and other collection data output formats at no charge.
Training. The Specify Software Project team will customize training to meet your
needs.
Taxonomic authority file creation. We will convert your existing taxon data records so
that you can use them as a controlled source of names for cataloging.
Assist with configuring the Specify web server interface and DiGIR Provider server
configuration.

To obtain assistance with customization or data migration as an evaluation user, call (785)
864-4400, 9 AM to 5 PM, U.S. central time.
Why Register?
To ensure effective use of project resources, we ask institutions that use Specify as their
primary collections database management system to register with us. Registration is free, and
it qualifies your department or institution for a level of technical support services not available
to evaluation users. Registering Specify also allows us to document Specify usage, which
helps to secure grant support. On the registration form we ask for basic information about your
collection and the data you plan to manage in Specify.
How to Register
Once you have installed Specify, registration forms can be found in the Specify program
installation directory. There you will find two versions of registration form: registration.doc and
registration.txt. After you fill one out, mail or fax the registration form back to us, and then we
can help you with form customization, search templates, report customization, and general
problem solving.
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Attach a Database
SQL Server uses MDF files for storing database information. To use this information, the MDF file
must be attached to the server. These MDF files are typically placed in the Microsoft SQL Server
data folder. If you use the default SQL Server 2005 Express installation, these files will be in
C:\Program Files\Microsoft SQL Server\MSSQL.1\data.
There are three ways to attach a database
1. Attach your own converted database (as in this example) either from a previous version of
Specify or a conversion from a legacy system performed by Specify staff.
2. Attach the Fishdemo Database distributed with Specify to provide users with sample data
and forms. To see how to attach a Fishdemo Database, see Attach a Blank or Fishdemo
Database.
3. Attach a Blank Database to begin the process of starting a new collection database from
scratch. To see how to attach a Blank Database, see Attach a Blank or Fishdemo
Database.
How user accounts are handled
If you detach then reattach a database, Specify will, on reattaching, reinstate the user
accounts that were originally created for that database as long as the usernames are not
already in use on the target machine. For instance, if the original user was ABentley and it was
associated with a different database, Specify will create an ABentley1 user and assign that
account to the database instead of ABentley. If, in this situation, you need to keep exactly the
same user name, open Enterprise Manager and delete those user accounts. Then, when you
reattach the database, Specify will reinstate the user accounts without adding any numbers.
To attach a database:
1. Start Specify. The login window appears.
2. In the Server field, select the server name from the drop-down list. If this is a new Specify
installation, you may need to type in the server name.
3. Enter the sa user name and password for the SQL Server to which you want the
database attached.
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4. From the drop-down list at the bottom of the screen, select Attach Specify Database.

5. Click OK.
6. Go to Program Files/Microsoft SQL Server/MSSQ.1L/Data. There will be a list of available
databases. Select the appropriate database and click Open.

7. Click Open.
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8. An attach confirmation dialog will appear. Click OK.

9. Followed by a message that Specify will now update the user accounts for the database.
Click OK.

10. A dialog box confirming the database has been attached will appear. Click OK.

11. Login to Specify.

Attach a Blank or Fishdemo Database
The Blank Database can be used as a template for all collection types. This is the procedure to
follow if you are new to Specify and thus have not yet created a database or are creating a
new database. To create a particular collection type, attach the blank database then import the
appropriate Taxonomic Authority file, either your own or from the Specify website. To see how
to Import a Taxonomic Authority File refer to the section so labeled later in Starting Specify. If
you want to attach the Fishdemo database, substitute Fishdemo for BlankDatabase in this
procedure.
To attach a blank database:
1. Copy (NOT move) the blank database from the MDFStartupFiles folder within your
Specify folder ...
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... and paste it into the Data folder within your MSSQL.1 folder.

2. Start Specify.
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3. Enter the server name. Enter sa in the user name field and in the password field enter
your SQL Server password. The database name box should be empty.

4. Change the operation drop-down list from Login to Attach database as shown above.
5. Click OK.
6. Navigate to the Blank Database by going to Program Files/Microsoft SQL
Server/MSSQ.1L/Data. You may also find a copy of the Fishdemo database in the mdf
startup files folder within the Specify folder.
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7. Select the BlankDatabase2005.mdf and click Open.
8. After you click OK to attach your database, enter a password for the designated top level
user and confirm the password by entering it a second time.
The top level user of the Blank Database is topdog_BlankDatabase2005. The top level
user for the Fishdemo is ExampleAdministrator. There are more users for the Fishdemo
database. You will be prompted to enter passwords for each of these users.
9. When you return to the Specify Login page, you may need to enter the database name,
user name, and password in the appropriate boxes.
You are now ready to set up a collection using the blank database. Refer to Create a
Collection Definition.

Choosing a Collection Configuration
Choosing a Collection Configuration
Before launching your own implementation of the Specify database, consider the following
options for subdividing your collection. These options are particularly useful for collections with
specimens from different disciplines or collections that require some logical subdivision. Your
choice among these alternatives depends on the contents of your collection and the collection
management practices of your institution.
•

Setting up Multiple Separate Specify Databases Stored in Independent Files

•

Setting up Multiple Taxonomic Discipline Collections in a Single Database File. This
option may be applicable to herpetologists who want to combine amphibian and reptile
records in a single database.

•

Setting up Multiple Catalog Series

Multiple Separate Specify Databases Stored in Independent Files
If your collection contains specimens from multiple disciplines, such as botany and ichthyology,
and you place each discipline in a separate database, the multiple databases do not share any
forms, searches, reports, or data. Each database has its own set of forms, and the forms in
one database are independent of those in other databases. Separate Specify databases
allows for maximum flexibility for customization to disciplinary work practices. For example,
ichthyologists and botanists can customize their data-entry forms in ways that best
accommodate their respective “lot” and “specimen” perspectives on collection objectives.
This configuration is common in larger museums where collections are administered and
maintained separately for each taxonomic discipline. Because the databases are separate, a
query or report draws from only one database. You cannot simultaneously search multiple
databases within Specify to find all specimens (regardless of discipline) collected in a given
year or all specimens loaned to a given institution — unless you log in to each database
separately and run separate searches.
Multiple Taxonomic Discipline Collections in a Single Database File
You may want to maintain records for more than one discipline in a multidiscipline collection
database by configuring Specify to support multiple biological object types. A biological object
type is a property that defines the type of collection (plant, fish, mammal, insect). You choose a
biological object for the collection when you first set up your Specify collection. You can
choose more than one biological object type when you set up the collection. Or, if you choose
only one type when you set up your collection and want to add another type, you can modify
your collection later to support additional types.
Because collection practices differ among the disciplines, requirements for a fish data entry
form are different from requirements for a bird data entry form. Specify therefore maintains a
separate set of certain forms for each discipline. If you configure your database to support
multiple disciplines, Specify maintains separate versions of any discipline type-dependent
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forms (namely, the Collection Objects, Collecting Event, Taxon Name, Determination, and
Attributes forms) and uses a common version for all forms (such as Localities) that are
independent of type. If the fish and mammal forms are both enabled in the same database,
each discipline has a separate customizable Collection Objects form, but both disciplines
share common Loan, Accessions, Borrow, and Agents forms.
In multidiscipline collections, Specify automatically uses the correct data form for each
collection record. If your search turns up a bird record, the record appears with the bird data
form. The Grid view separates the results according to biological type. As shown in the
following figure, search results for different biological object types are separated into different
tabs in the Grid view.

Creating a single database with multiple biological object types has the following advantages:
•
•

•

Simplified file management — You have only one collection database to back up and
administer.
Better management of common data — The different disciplines share common records,
such as localities, agents, and references. With separate databases, on the other hand,
common data must be entered separately in each database. A change to one database
(such as editing a lender’s address) does not update the other database.
Unified search interface — You can simultaneously search across multiple object types.
For example, you can search for all collection objects of any taxonomic type loaned in
1989. Or, you can find all specimens, regardless of type, collected in Costa Rica.

Creating a multidiscipline database has the following disadvantages:
•
•

•

Performance —It takes longer to search a large database. Combining multiple disciplines
in a single database file increases the number of specimens in the database and therefore
may affect performance.
Single point of failure — If a problem arises with the database, none of the disciplines will
be able to access their data until the problem is fixed. If, on the other hand, the data is
held in multiple databases, a problem with one database will affect only the users of that
database.
Complexity — In multidiscipline collections, Specify tracks search results by biological
object type. Most of the management of biological object type occurs invisibly within
Specify, but the user occasionally has to click through additional tabs showing the results
by type. Also, the disciplines must agree on a common format for type-independent forms,
such as the Loan, Agent, or Accessions form.

Multiple Catalog Series
Specify's multiple catalog series feature lets you create logical groups within a collection. Each
catalog series is identified by a distinctive prefix before its own series of catalog numbers. You
can use catalog series to reflect internal administrative or legal subdivisions within your
collection. For example, specimens located in different buildings can have distinctive catalog
series. By the same token, a single staff might manage collections with differing legal or
historical identities. Specify allows collections managers to group collection objects based on
just about any criteria. In our example, someone can run a search that limits its results to
records within the appropriate catalog series based on any combination of location, legal
identity, and historical identity.
When you set up your Specify database, consider whether it would help you to use the catalog
series feature to create logical groups within your collection.
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Multiple catalog series adds some complexity. The default Specify configuration places all
records in a single catalog series called MAIN. The single MAIN series is sufficient for many
collections. However, if you are accustomed to maintaining records in multiple series, or if you
feel your collection might benefit from a multiple-series configuration, refer to Add a Catalog
Series.
Within a single catalog series, Specify issues a unique catalog number to each of your
specimens. If you use only one series, only the catalog number component is required to
identify a specimen in a report. On the other hand, if you have two or three catalog series —
for example, MAIN, TEACHING, and IMAGES — there will be multiple sets of catalog numbers
and possibly duplicate catalog numbers among the sets. You need to include the catalog
series prefix in any report that references the specimen by catalog number. The specimens
(collection objects) in the Grid view display the catalog series prefix and catalog number
together as if they were a single field.

Create a Collection Definition
To Create a Collection Definition:
1. Start Specify. The Login dialog box appears. The Server and Database fields should
already be populated after attaching the blank database.

2. If you are running Specify from a different computer than the one on which the database
is installed, you may need to enter these items the first time.
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3. Check the server name. Select the blank database you attached (see Attach a Database)
from the Database drop-down list, and then fill in the User Name and Password you used
during the attach process.
4. Click OK. A dialog box tells you to set up a collection.

5. Click OK. The Basic Collection Setup dialog box displays. Enter a collection name and
collection abbreviation. The collection abbreviation becomes part of the collection object
identifier for specimens entered in the collection.
6. Select a specimen type for your collection. (To select multiple types for creating a multitaxon database, hold down the Ctrl key while you select specimen types in the list.)

7. After you have entered the necessary information, click OK. Specify adds the collection
definition (or definitions) to the database. This process may take several minutes.
8. When Specify opens, you can enter or import taxonomic data, save your changes to the
new database file, set up users, or perform other Specify tasks.
9. The collection definition table also contains the following fields, which are not configured
through the Startup dialog box. You can configure them later.
•
•
•

•
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Description — additional text describing the nature or mission of the collection. This
text is optional and is not displayed on any of the data entry forms.
Remarks — Optional text describing the current status of the collection.
Organization — The abbreviation or ID code for your institution. This field refers to an
organization definition entered through Specify's Agents form. Organization data can
include information such as employees, addresses, and the names of sponsoring
institutions. You must enter the organization information through the Agents form
before you can reference it through the collection definition.
Catalog Series — An internal subdivision for data in a single collection.
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Customizing Specify's Graphics
Specify's user-centered flexibility includes the option to "personalize" the images displayed by
the application. You can replace the images that appear in the Specify login window and
workspace with artwork that represents your institution. (The login window is displayed after
you double click the Specify icon. The Specify workspace appears to the right of the navigation
panel after Specify has opened.)
Your alternate image should be in .bmp format and should be in the following size ranges:
• login image: 525 pixels wide and 207 pixels high (or smaller). The size of this image
depends on your screen resolution.
• workspace image: 800 x 600 pixels is a good starting point for a workspace image file
size, and the default logo image installed with Specify is that size. Specify will resize the
workspace image as you increase or reduce the size of your Specify window, the graphic
will maximize up to the size of the underlying image BMP file, but not larger. If you have a
large monitor and would like to increase the maximum size of the workspace image, we
have included a larger BMP format file of the Specify logo, sized at 1200 x 800 pixels. You
are free to customize Specify with a BMP format image of your own choosing — perhaps
a logo, or specimen image, or nature scene. The exact pixel size of any image you might
prefer is not critical, Specify will resize it to fit within the window.
To Change an Image in Specify:
1. Use Windows Explorer to navigate to this folder: C:\Program
Files\Specify\Specify\images:

Note: If you want to retain a copy of the original login image, add a letter or number after
the file name. For example, Specify.bmp becomes Specify1.bmp. That way, you can
restore the original image by returning the original name if you need to.
2. To change the login image, copy your replacement image to the images folder and
rename to Specify.bmp.
3. To change the workspace image, copy your replacement image to the images folder and
rename to SpecifyWorkspace.bmp.
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Initial Procedures for Specify
Overview
Setup Overview
Because Specify is a versatile application, the range of options may at first seem bewildering.
The topics in this section provide a no-frills, process-oriented discussion of how to set up
Specify.
After you have installed Specify and started it for the first time, you'll need to set up Specify for
your own collection. The process for setting up Specify includes the following tasks:
•

Create a Collection Definition

•

Import a Taxonomic Authority File

•

Set Up User Accounts

•

Set Up Specify Preferences

Localization Overview
Localization of a software application, also known as internationalization, means translating its
text elements from the original language of the application to a target language and
incorporating the translated text into the application's source code files. In the case of Specify,
localization involves translating some or all of the user interface elements that contain English
text into any target language that uses the Roman alphabet. (Specify cannot currently be
localized for a non-Roman alphabet). The Specify Software Project team offers some
assistance in the localization of Specify.
Collection Definitions
Before you can enter data into a new Specify database file, you must create a collection
definition. Each database file can have only one collection definition.
A collection definition describes the types of biological objects contained in the database and
the scheme used to catalog the objects. The taxonomies used in the database are also
defined, as well as associations between biological object types and taxonomies. In addition,
fields are provided for information identifying the collection, such as the collection name and a
prefix that can be included with catalog numbers in reports. The prefix is usually an
abbreviation for a collection or institution.
Finally, detailed address and contact information for your institution can be specified. For more
information, refer to Create a Collection Definition.
Catalog Series
Each collection definition can contain one or more series of catalog numbers. A catalog series
is a subgrouping of specimens in the collection. You can use a catalog series to group
specimens according to taxonomy type, physical location, or any other criterion.
Each specimen you enter into your Specify collection is associated with a catalog series. The
default catalog series is MAIN. Many collections simply place all collection objects into MAIN
and ignore the option of using multiple catalog series. To learn how to create an additional
catalog series, refer to Add a Catalog Series.
Biological Object Types
Each catalog series is associated with one or more biological object types. A biological object
type is a taxonomic type (fish, reptile, mammal, plant, etc.) associated with a catalog series.
Specify supports natural history collections from several disciplines, and each discipline has
different requirements for storing information. Specify, therefore, includes a different set of data
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forms for each biological object type. When you create a collection, you tell Specify which set
of data forms to use for collection data.
When you create a collection definition, Specify performs the following tasks:
•
•
•
•

Creates a collection definition with the name and abbreviation you assign.
Creates the MAIN catalog series.
Associates any biological object types you choose in the list (fish, reptile, plant, etc.) with
the MAIN catalog series.
Eliminates all unnecessary fields from the data model.

For step-by-step instructions on creating a collection definition, see Create a Collection
Definition.
After you create a collection definition, you can modify that definition (see Modifying a
Collection's Properties). You can change the collection name or collection abbreviation, add a
catalog series, or associate additional biological types with a catalog series. You cannot delete
a collection definition if you have collection records entered into your database. However, if
you have not yet entered any collection records, you can delete the collection definition and
start over.

Collection Definitions
Modifying a Collection's Properties
With Administrator security level, you can change your collection's name and identifier, as well
as add a catalog series or a biological object type to the collection.
To Modify a Collection's Properties:
1. Choose Tools > Admin > Modify Collection.
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2. Specify displays the search setup window for your collection table. Do not fill in any
condition rows.

3. Click Search. This generates a single row of results in grid view, as you have only one
collection.
4. Click Detail to display the form or double-click on the grid row you want to edit. Click Edit.

5. Change the collection name or identifier as desired.
6. Double-click either in the first empty row of either CatalogSeries or
CollectionTaxonomyTypes to add a new record to those related tables. For more
information, refer to Add a Catalog Series.
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Add a Catalog Series
Within a single catalog series, Specify issues a unique catalog number to each of your
specimens. If you use only one series, only the catalog number value is needed to identify a
specimen in a report. If, on the other hand, you have two or three catalog series — for
example, MAIN, TEACHING, and IMAGES — there will be multiple sets of catalog numbers
and possibly duplicate numbers among the sets. You will need to include the catalog series
prefix in any report that references the specimen by catalog number. If you use the series
prefix field, the Collection Objects Grid view displays the prefix and catalog number together as
a single field.
Usage Note: The term series on this page (catalog series) is not the same as the series in
series processing. The former defines a separate set of catalog numbers, whereas the latter
defines a range of catalog numbers whose records contain identical contents.
To Add a Catalog Series:
1. Choose Tools > Admin > Modify Collection Properties.

2. The search setup window for the Collections table appears.

3. Click the Search button at the bottom of the window to display the Grid view of the results.
It will normally contain a single row.
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4. Click the Detail button at the bottom of the window or double-click on the collection you
want to edit. The Detail view of the Collections record appears.
5. Click the Edit button so that you can add a new record to the CatalogSeries subform.
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6. Double-click the first blank row. The CatalogSeries dialog box is displayed.

7. Type the name of the new series in the Series Name box and the new prefix in the
CatalogSeries Prefix box. At the bottom of the form, enter any remarks to describe the
series.
8. Specify copies the current biological object type to the new catalog series record if you
have the carry forward option selected. That is normally the object type you will want to
use. If the copied value is correct, skip to step 10. Otherwise, follow steps 8-9 to change
the type.
9. Double-click on the CatalogSeriesDefinition field (it may be in formats other than the
button format shown above). The CatalogSeriesDefinition dialog box appears.
10. Click on the triangle in the ObjectTypeID box and choose the desired biological object
type:
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Note: The ObjectTypeID field associates the new catalog series with a biological object type.
Although all possible collection types appear in the drop-down list, any type can be selected. If
you choose a new type for the collection there needs to be an entry for it in the
CollectionTaxonomyTypes table. Therefore, choose one of the biological types you used when
you set up your collection or a biological type you added to your collection. For more
information, refer to Create a Collection Definition.
11. Enter any remarks and click Save.
12. Click Save in the CatalogSeries form to create the new catalog series.
13. Click Save in the Collections window.
Add a Biological Object Type to an Existing Database
To Add a Biological Object Type to a Database:
1. Choose Tools > Admin > Modify Collection Properties.

2. The search setup window for the Collections table appears.

3. Click the Search button at the bottom of the window to display the Grid view of the results.
It will normally contain a single row.
4. Click the Detail button at the bottom of the window or double-click on the collection you
want to edit. The Detail view of the Collections record appears.
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5. Click the Edit button so that you can add a new record to the TaxonomyTypes subform.
6. Double-click a blank line in the TaxonomyTypes grid.

7. The CollectionTaxonomyTypes dialog box appears.

8. Select a new TaxonomyTypeID and a new BiologicalObjectTypeID from the drop-down
lists. In most cases, the two values are identical.
Note: If you are adding the fossil invertebrate biological object, select the Invertebrate
Taxonomy Type. If you are adding a fossil vertebrate collection, you may want to associate
the biological object with multiple taxonomy types. For more information, contact the
Specify Project team. Contact Information can be found in the Welcome to Specify! section
of the manual.
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9. Click the Save button. Your new Taxonomy Type is added to the collection's Taxonomy
Types list.
10. In the Collections window, click Save.
You can now associate a catalog series with the biological object type you created in step 8.
For a discussion of catalog series in Specify and for a description of how to add a new catalog
series, refer to Add a Catalog Series.
Add a Biological Object Type to a Series
To Add a Biological Object Type to a Series:
1. Choose Tools > Admin > Modify Collection Properties.

2. The search setup window for the Collections table appears.

3. Click the Search button at the bottom of the window to display the Grid view of the results.
It will normally contain a single row.
4. Click the Detail button at the bottom of the window or double-click on the collection you
want to edit. The Detail view of the Collections record appears.
5. Click the Edit button so that you can add a new record to the CatalogSeries subform.
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6. Double-click the first blank row in the CatalogSeries Grid. The Catalog Series dialog box
appears.
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7. In the CatalogSeries dialog box, double-click a blank line in the CatalogSeriesDefinition grid.

8. The CatalogSeriesDefinition dialog box appears.

9. In the CatalogSeriesDefinition dialog box, click the triangle by the ObjectTypeID box and
select the object type corresponding to the type you selected in the Add a Biological
Object Type to an Existing Database procedure.
10. Click Save in the CatalogSeriesDefinition dialog box. The Object Type is added to the
Main Catalog Series in the Collections window.
11. In the CatalogSeries dialog box, click Save.
12. In the Collections window, click Save.
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Import a Taxonomic Authority File
Some collections prefer to use their own taxonomic data. For that reason, the taxonomic
authority file template file included with Specify does not contain a built-in taxonomic tree.
Specify does offer a variety of taxonomic authority files on its website. It is also possible
(though tedious) to build a taxon tree by entering taxon entries one at a time.
The following procedure assumes the Taxonomic Authority File to be imported into Specify is
already on the computer. Taxonomic Authority Files can be downloaded from the Specify
website located at: http://www.specifysoftware.org/Specify/taxonauthorityfiles . For more
information on Taxonomic Authority Files or the taxon tree, please refer to the Specify 5.2 Help
Guide.
To import taxon data:
1. There are two ways to get to step 2 depending on your starting point.
If you are already in the Taxon Tree window, from the Taxon Tree menu bar, choose
Taxon > Select Data to Import > <biological object type> where <biological object
type> is bird, fish, mammal, or whatever has been defined for your collection.

Or
If you are not in the Taxon Tree window, from the Specify menu bar, choose Tools >
Taxon Tree > Import Taxon Data.

The taxon tree window appears, showing your current taxon tree. If you are adding
taxonomy data for the first time, you see only a root node for each of your specimen types
(in this case, Fish). In the foreground you see the Select Taxonomic Authority File dialog
box.
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Note: A box may pop up asking Update Taxon Tree to be run. If this does occur, update
the tree before proceeding with importing the taxon tree. For instructions on updating a
taxon tree, refer to the Updating the Taxon Tree section of the Specify 5.2 Help Guide.
2. The Taxonomic Authority File dialog box appears. Browse to the taxonomy file you want
to import and click Open.

A login dialog box may appear, asking you to enter a password to open the taxonomy file.
The contents of the taxonomy file are displayed in the Taxon window. The red boxes
indicate that the associated taxon is not yet selected for importing.

3. Click the plus (+) sign beside any node to view the subtree beneath that node.
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4. Check the box beside the node that contains the taxon or taxa you want to import. A red
check mark replaces the box, and all child nodes beneath it are also checked.

5. Deselect any child node or child branch that you don't want to include in the import.
6. When you have selected the taxa you want to import, choose Taxon > Import. Specify
imports the taxonomy data. You may see a warning for duplicate taxonomic entries or a
prompt for parent node information. If you are importing a large database, the import
process takes a long time.
7. When the import is complete, choose Taxon > Redisplay Local Taxonomic Data to
dismiss the view of the imported tree and show your Specify taxon tree again.
A Confirm dialog box prompts you to perform an update.

Until you perform an update, any changes to the taxonomy database will not be reflected
in Specify's taxon tree view.
8. Do one of the following:
•
•

If you want to update immediately, click Yes
To perform the update later, click No. When you're ready to update, come back to the
Taxon window and choose Taxon > Update Taxa Tree (<type>), where <type> is a
placeholder for mammal, fish, or whatever biological type your collection was defined for.
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Set Up User Accounts
Specify provides a multi-user, multilevel security system for controlling access to the
collections database. In Specify, a user must supply a password to access to the collection.
Each user is associated with one of five built-in security levels. Each level has a predefined
combination of privileges. When you assign a user to a group, you grant the user all the
privileges belonging to that group.
The five Specify security levels are:
•

Administrator, which lets the user perform any Specify task.

•

Manager, which lets the user perform any task related to collection data and
customization but not add, delete, or modify users. Managers also cannot make changes
to the structure of the collection.

•

Full Access User, the lowest security level that can synonymize taxa.

•

Limited Access User is similar to Full Access Users, except Limited Access Users are not
permitted to synonymize and desynonymize taxa.

•

Guest, which has only the privilege of viewing data.

The Fishdemo and blank databases are set up with a default account for the Administratorlevel user. For the Fishdemo database, the user is Administrator. There is a user for each
security level already set up for the Fishdemo database. The user accounts are named for
their privilege ranking: Administrator, Manager, FullAccessUser, and so on. You will not need
to enter any new user accounts for the Fishdemo except for practice.
After you Install Specify and log on through the Administrator account, you should create new
user accounts for the users who will be accessing your Specify database. Create an account
for each Specify user, and provide each user with the appropriate group membership.
Important: Create another Administrator account before you delete admin. Make sure you
remember the password of your Administrator account.
If you delete the admin account and then forget your Administrator password, the Specify team
will not be able to help you gain access to your system. You must log on under the new
Administrator account before deleting the admin account.
To learn more about Specify security, refer to Introduction to Specify Security in the Specify
5.2 Help Guide.
Creating User Accounts
Creating Specify user accounts confers the following advantages:
•
•
•
•

User-specific security — You can restrict a user to a specific set of security settings. Refer
to Introduction to Specify Security and Setting Up User Accounts.
User preferences — Each user can set personal preferences for settings such as data
and latitude/longitude format. See Setting Date and Latitude/Longitude Format.
User-specific searches and reports — A user can save searches and reports that are
stored under the user's name for later reference.
Password control — Each user has an individual password. This is a safer approach than
allowing multiple users to share the same password.

In high-security environments, it is important to delete built-in accounts with publicly known
passwords. After you have created your own user accounts, you should delete the built-in
Specify account or change its password. However, any saved searches or reports associated
with a deleted account will be inaccessible.
Important: Make sure that you create new administrator-level account before deleting the
original.
For a discussion of how to create Specify user accounts, please refer to the Specify 5.2 Help
Guide.
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Specify Preferences
Users can set default settings in Specify data entry and field captions to best suit the individual
institution.
Setting Up Localization
Setting up Localization will translate most of Specify's text elements from English into the
target language. Data form fields are not translated in this procedure. These fields can be
translated using the Form Customizer by editing the captions of fields and replacing English
text with the target language text. Instructions on these procedures are located in the Specify
5.2 Help Guide. At this time, the only available additional language is German. If you are
interested in working with the Specify team to translate Specify into another language, contact
the Specify Project team. Contact information can be found in the Welcome to Specify! section.
To translate "hard-coded" controls, such as menu items and buttons, you can send the
translated names to the Specify team on a special language spreadsheet, and a developer on
the team will incorporate your translation into a fully localized version. This service is offered at
no charge, but the Specify team will retain the right to distribute your translated text to other
users of the same language. If you would like to pursue this possibility, please contact the
Specify Software Project. Localization of Help text is not supported.
You must import language files for each of your Specify databases. If you are using Specify
3.2 or earlier, contact the Specify team for information about setting up localization. Also,
existing localized versions of Specify become outdated when a new version is shipped. They
will need to be revised to include new and changed features with each new version.
Foreign-language versions of SQL server and our English-language databases are not always
compatible, so there may be some problems with data entry, particularly time stamp fields.
To Set Up Localization:
1. Start Specify and log in to the database for which you want to change the language.
2. After the upgrade, from the Specify menu bar, choose Tools > User Preferences >
Choose Language. The Preference dialog box appears and displays the Language tab.
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3. Choose Other from the drop-down list and click Save.

4. You'll be asked if you are sure you want to activate additional languages. Click Yes.
5. The resulting box will ask if you want to continue using your current field captions, which
you may have already edited. If the answer is yes, select English or Deutsch, whichever
language you want to have the captions displayed in. If the answer is no, leave Use
Default Form Captions selected.

196

Getting Started in Specify
6. Click OK to continue. The Language Preferences dialog box now includes Deutsch (or
other language, as more become available) in its drop-down list. Select the desired
language and click Save.

7. Click Save. Specify now appears in its German version.
8. Restart Specify to see all language changes.
To Switch Back to English
1. Choose Tools > User Preferences > Choose Language.
2. In the Language Preference dialog box, go to the Default Language box and select
English from the drop-down list.

Clicking the Deactivate Languages button switches off the loading of German menu
options into memory.
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3. Click Save.
4. Restart Specify after deactivation.
Note: It is up to the user to perform and quality-check the translation. The Specify Software
Project does not provide management of language conversions nor is it responsible for the
accuracy of a conversion. It does provide the tools to generate the language files and can
make them available to the original translating client, as well as to other users, after a
conversion is completed.
User Preferences
Setting Specify Preferences
Specify includes preference options that apply to each Specify user rather than to the program
itself. Preferences are stored with the account information (user name and password) that you
enter when you log in to a Specify database.
To view user preferences, choose Tools > User Preferences from the Specify menu bar:

Each secondary menu command is described in the table below.
Choose Focus Color

Lets you modify the color used to highlight subforms when
editing records.

Choose Language

Lets you choose the language that Specify will use in its
menus, window title bars, dialog boxes, and so forth.

Choose Form Sets

Lets you choose a group of standard data entry forms that
have been simplified for speed and ease of use.

Setup Statistics

Lets you designate whether and how long statistics are
displayed as you exit Specify.

Set Field
Masks/Series

Lets you choose how dates, latitudes, longitudes, and numeric
series are displayed.

Setting the Focus Color Preference
The focus color is used to highlight various sections of a form when you are in data entry or
edit mode. The default focus color is black.
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To Select a Focus Color for Your Data Forms:
1. Choose Tools > User Preferences > Choose Focus Color.

2. The Preferences/Focus Color dialog box is displayed.

3. Click the color you want to use as the focus color for data forms.
4. Click Save.
Setting the Form Set
With Specify you can tailor your data forms to the needs of your own collection and to the
preferences of the persons who are updating it. For example, you can hide data fields you do
not need or add data fields that are not included in the default configuration. You can display
simplified versions of forms for persons who only need to work with a small number of fields.
You may want to use Specify for a few weeks before customizing the user interface, simply to
gain familiarity with it. However, there are advantages to settling on customized form designs
at the outset. For instance,
•
•

Simplicity — If you customize your data forms before you start entering data, data entry
personnel will have to learn the forms only once and will not have to adapt later to a new
form design.
Uniformity — If you customize your data forms before you start entering data, all entries
will include the same fields. If you add or remove data fields after you start entering data,

199

Specify 5.2 Installation and Setup Guide
some entries will include fields that are not present in other entries. Specify does not
require perfect uniformity to function, but a data field that is not used consistently in the
database may be unreliable as a search criterion. For instance, if the data field
"wingspan" is used for some but not all collection objects in a bird collection, a search for
a bird’s wingspan will ignore any records in which the wingspan field is not used.
You may want to experiment with modifying data entry forms at the beginning and then finalize
your design later as you become more familiar with Specify. To see how to edit Specify Forms,
refer to the Specify 5.2 Help Manual.
Setting the Database Statistics Page
Specify can display your collection's statistics in abbreviated or expanded forms:
•
•

A summary that appears under the Statistics heading in the navigation panel.
A comprehensive list that can be displayed as you exit Specify or when you click the word
Statistics in the navigation panel:

You can customize whether and how long the Database Statistics dialog box appears as you
exit Specify.
Note: Some statistics may appear incorrectly if there have been some modifications made in
the standard way that information is stored.
For example, the Type Status field is used to calculate the Type specimens. It counts all
specimens that do not have the value of <No data>. The statistical calculation will not be valid
for your database if you use another phrase for <No data> or if you are using another field to
track your type specimen. If you have any questions about a statistical calculation, please
contact the Specify helpdesk. Contact information is located in the Welcome to Specify!
section.
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To Customize the Display of Statistics for Your Collection:
1. Choose Tools > User Preferences >Setup Statistics.

2. The Preferences dialog box appears.

3. To cause the Database Statistics dialog box to be displayed at the end of a Specify
session, check the Show box, then do one of the following:
•
•
•

To display the Database Statistics dialog box for a certain time when Specify exits and
then have the Statistics box close itself automatically, type a positive integer in the "for
__ seconds" box.
To keep the Statistics box open and ask the user close the Database Statistics dialog
box when he or she is ready, type a negative number in the "for __ seconds" box.
To prevent the Database Statistics dialog box from being displayed when Specify
exits, type 0 in the "for __ seconds" box. This has the same effect as clearing the
Show box.

4. Click Save.
Additional Features
•
•

To refresh the Statistics subheadings in the navigation panel, click the Update Statistics
button.
To display the Database Statistics dialog box, click the View Expanded Statistics button.
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Setting the Field Masks/Series
There are three categories that can be formatted within Field Masks/Series: Date,
Latitude/Longitude, and Numeric Series.
To edit any of these:
1. From the Specify menu bar, choose Tools > User Preferences > Set Field
Masks/Series.
2. The Preferences/Field Masks dialog box appears.

From this point, any of the three categories can be altered.
To Set the Date Format for Your Forms:
The default date mask is automatically applied to default formats, date query controls, time
stamp fields, statistics displays, and anywhere else a date needs to be displayed. However,
the mask does not overwrite user-customized date masks on forms unless you click Yes in
step 3 below.
1. From the Dates Default Mask list select the arrangement you want to use.
2. Click Save. Users with Manager or Administrator security level are prompted to apply (or
not apply) the selected formats to all their forms.

3. Click Yes to overwrite current date masks in forms with the default date mask, or click No
to leave them unchanged.
4. If there you do not want to make changes to any of the other categories, click Save at the
bottom of the screen, otherwise, continue to the next section.
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To Set the Latitude and Longitude Format for Your Forms:
1. From the Lat/Long Default Mask list select the arrangement you want to use.
2. Click Save. Users with Manager or Administrator security level are prompted to apply (or
not apply) the selected formats to all their forms.

3. Click Yes.
4. If there you do not want to make changes to any of the other categories, click Save at the
bottom of the screen, otherwise, continue to the next section.
To Set the Numeric Series Format for Your Forms:
1. From the Numeric Series list select the arrangement you want to use.
2. Click Save.
Setting Automatic Assignment of Catalog Numbers
You'll use the auto-assign option to create catalog numbers when your collection does not
have its own set of catalog numbers for specimens. Although Specify requires these numbers,
after you switch on the option, you can disregard the catalog numbers.
Your security level determines whether the Automatically Assign Catalog Numbers feature is
available. Only Administrator, Manager, and Full Access users can use this feature. In
addition, Automatically Assign Catalog Numbers cannot be activated if series processing is
selected.
To Switch on Automatic Assignment of Catalog Numbers:
1. From the Specify menu bar, choose View > Auto-Assign Catalog Numbers.

2. The Auto-Assign Catalog Numbers menu item should now have a check mark next to it.
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Setting the External Link Preference
This page shows you how to change the link that Specify uses for its ITIS (Integrated
Taxonomic Information System) Internet connection.
To Set the External Link Preference:
1. Choose Tools > Admin > External Link Settings.

2. The Internet Preference dialog box appears.

3. Change the ITIS server link if necessary. If you need to restore the original link, click the
Default Servers button.
4. If you want to use Specify's simple built-in browser instead of your computer's default
browser, click the Use Specify Browser option.
5. Click Save to store your changes and dismiss the dialog box.
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